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 Complete teacher’s manual for Open office impress 2 Class 1 

 Summaries 

 

 What is ‘Standard toolbar’? 

 Why we use ‘Standard toolbar’? 

 How to take new slide by using ‘Standard toolbar’? 

 How to open any file with help of ‘Standard toolbar’? 

 How to convert text document file into a PDF file? 

 How to insert a table with help of ‘Standard toolbar? 

 Why we use ‘Fontwork’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to hide and unhide ‘Line and filling toolbar’?  

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

1. To stop video time at 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 सकंेि ।  

 

Stop video here and ask how to type in blank slide? 

विवियो को रोके और पछूें  ब्लैंक स्लाइि मे टाइप कैस ेकरत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

2. To stop video time at 1 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 00 सकंेि ।  
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Stop video here and ask how to insert a new slide and how many methods are 

there to insert a new slide’? 

विवियो को रोके और पछूें नयी को कैस ेइन्सटट करत ेहैं और न्यू स्लाइि को ककतन ेतरीके स े

इन्सटट कर सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

3. To stop video time at 1 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 30 सकंेि ।  

 

Stop video here and ask which option is used for animation? 

विवियो को रोके और पछूें एवनमेशन लगान ेके वलए ककस विकल्प का उपयोग करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

4. To stop video time at 1 minute 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 45 सकंेि। 
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Stop video here and ask what should we  do to copy an object such that whose 

colors are different? 

विवियो को रोके और पछूें एक से ज्यादा कॉपी करन ेके वलए क्या करेंगे और वजसका कलर 

अलग-अलग आए। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

5. To stop video time at 2 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 05 सकंेि। 

 

Stop video here and ask students to open ‘Impress file’. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

6. To stop video time at 3 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 13 सकंेि। 
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Stop video here and ask students to insert five slides and ask them to type 

something in the first slide and then play the video again. 

विवियो को रोके और विद्यार्थटयों को पााँच स्लाइि इन्सटट करन ेको कहें और पहले स्लाइि मे 

कुछ टाइप करन ेको कहें और किर आगे विवियो को प्ले करें। 

7. To stop video time at 3 minute 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 24 सकंेि। 

 

Stop video here and ask students to draw any shape on 2 and 3 slides and also 

ask them to do formatting on these shapes and then play the video again. 

विवियो को रोके और विद्यार्थटयों को 2 से 3 स्लाइि पर कोई शेप ड्राि करन ेको कहें और 

उसमे िोमटेटंग करन ेको भी कह ेऔर किर आगे विवियो को प्ले करें। 

8. To stop video time at 3 minutes 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 38 सकंेि। 



   

 Supported By “Human Development Foundation” 7 
 
  
 

 

Stop video here and ask students to insert any object with help of  ‘Gallery’ 

option and in the 5
th
 slide draw their name with help of  ‘Fontwork’ option and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को 4th स्लाइि मे गलॅरेी विकल्प की मदद स ेकोई ऑब्जेक्ट 

इन्सटट करन ेको कहें और 5th स्लाइि मे िॉन्टिकट की मदद स ेनमे को ड्रॉ करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

9. To stop video time at 3 minutes 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 52 सकंेि। 

 

Stop video here and ask students if they’ve done all these five things in impress 

file and then play the video again. 

विवियो को रोके और विद्यार्थटयों से पछूें क्या य ेसभी पाचंों कायट इम्प्रसे की फ़ाइल मे कर 

चकेु हैं या नहीं और किर आगे विवियो को प्ले करें। 

10. To stop video time at 4 minutes 27 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 27 सकंेि। 

Stop video here and ask students to insert 5 slides as shown in the video and 

then play the video again. 
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विवियो को रोके और विद्यार्थटयों को पााँच स्लाइि इन्सटट करन ेको कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

11. To stop video time at 7 minutes 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 44 सकंेि। 

Stop video here and ask students to type the given paragraph as shown in the 

video and also ask if  they can type about themselves,they can do that too and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को विवियो मे कदये गए परैाग्राि को टाइप करने को जसैा 

की विवियो मे कदखाया ह ैऔर उनस ेयह कहें की िे अपने बारे मे भी टाइप करते कर सकत े

हैं। 

12. To stop video time at 8 minutes 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 30 सकंेि। 

Stop video here and ask students to draw any shape as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को कोई शपे ड्रॉ करन ेको कहें जसैा की विवियो मे कदखाया 

गया और किर आगे विवियो को प्ले करें। 

13. To stop video time at 9 minutes 57 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 57 सकंेि। 

Stop video here and ask students to do the formatting on the image as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र पर िोमटेटंग करन ेको कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

14. To stop video time at 10 minutes 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 40 सकंेि। 

Stop video here and ask students to draw another shape as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक और शपे ड्रॉ करन ेको कहें जसैा की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

15. To stop video time at 11 minutes 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 39 सकंेि। 

Stop video here and ask students to do the formatting on the image again as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र पर किर स ेिोमटेटंग करन ेको कहें जसैा की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 
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16. To stop video time at 13 minutes 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 10 सकंेि। 

Stop video here and ask students to insert any picture with help of ‘Gallery’ 

option and then play the video again. 

विवियो को रोके और विद्यार्थटयों को गैलरेी विकल्प की मदद स ेकोई वचत्र इन्सटट करन ेको 

कहें जसैा की विवियो म ेकदखाया गया और किर आगे विवियो को प्ल।े 

17. To stop video time at 14 minutes 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 26 सकंेि। 

Stop video here and ask students to apply the master pages on the 4
th

 slide as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को 4th स्लाइि पर मास्टर पजे को लगाए जसैा की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

18. To stop video time at 16 minutes 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 40 सकंेि। 

Stop video here and ask the students to write their name with help of 

‘Fontwork’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को िॉन्टिकट की मदद से अपना वलखन ेको कहें जसैा की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

19. To stop video time at 16 minutes 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 45 सकंेि। 

 

Stop video here and ask them if they remember what is ‘Standard toolbar’? 

विवियो को रोके और विद्यार्थटयों से पछूें क्या उन्ह ेयाद है स्टैंििट टूलबार क्या होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

20. To stop video time at 17 minutes 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 34 सकंेि। 
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Stop video here and ask them,  there are how many methods to take an ‘Impress 

file’? 

विवियो को रोके और पूछें इम्प्रसे की फ़ाइल को ककतन ेतरीके स ेले सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

21. To stop video time at 18 minutes 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 41 सकंेि। 

Stop video here and ask students to take a new file by the first method as shown 

in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को पहला तरीका स ेनयी फ़ाइल लने ेको कहें जसैा की 

विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

22. To stop video time at 19 minutes 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 14 सकंेि। 

Stop video here and ask students to take a new file by the second method as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को दसूरा तरीका स ेनयी फ़ाइल लने ेको कहें जसैा की 

विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

23. To stop video time at 19 minutes 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 43 सकंेि। 

Stop video here and ask students to take a new file by the third method as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को तीसरा तरीका स ेनयी फ़ाइल लने ेको कहें जसैा की 

विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

24. To stop video time at 20 minutes 49 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 49 सकंेि। 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

25. To stop video time at 21 minutes 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 41 सकंेि। 

Stop video here and ask students to save their file as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को अपनी फ़ाइल सिे करन ेको कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

26. To stop video time at 21 minutes 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 46 सकंेि। 

 

Stop video here and ask which shortcut command will be used to open ‘Impress 

file’? 

विवियो को रोके और पूछें इम्प्रसे की फ़ाइल को ओपने करन ेके वलए कोनसी शॉटटकट कमािं 

का उपयोग करेंग।े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

27. To stop video time at 22 minutes 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 00 सकंेि। 
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Stop video here and ask can they open ‘Impress file’with help of ‘Standard 

toolbar’? 

विवियो को रोके और पूछें क्या आप स्टैंििट टूलबार की मदद स ेइम्प्रसे की फ़ाइल को ओपने 

कर सकत ेहैं। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

28. To stop video time at 22 minutes 57 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 57 सकंेि। 

Stop video here and ask students to close their current file and ask them to open 

impress file again as shown in the video and then play the video again. 

विवियो को रोके और विदायर्थटयों को अपनी फ़ाइल को क्लोज़ करन ेको कहें और इम्प्रसे की 

फ़ाइल को किर स ेओपने करन ेको कहें जसैा की विवियो मे कदखाया ह ैऔर किर आगे 

विवियो को प्ले करें। 

29. To stop video time at 23 minutes 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 16 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

30. To stop video time at 24 minutes 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 17 सकंेि। 

Stop video here and ask students to open their file with help of ‘Open’ option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ओपने विकल्प की मदद स ेफ़ाइल ओपने करन ेको कहें 

जसैा की विवियो मे कदखाया गया है और किर आगे विवियो प्ले करें। 

31. To stop video time at 25 minutes 16 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 16 सकंेि। 

Stop video here and ask students to click on the ‘Document as email’ option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को िॉकयमुेंट एज़ ईमेल विकल्प पर वक्लक करन ेको कहें 

जसैा की विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

32. To stop video time at 26 minutes 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 12 सकंेि। 

Stop video here and ask students to use the ‘Send’ option as shown in the video 

and then play the video again. 

Note: -  tell students there is no need to click on ‘Send’ button since internet 

connection is required to send an email. 

विवियो को रोके और विद्यार्थटयों सेंि विकल्प का उपयोग करन ेको कहें जसैा की विवियो मे 

और किर आगे विवियो को प्ले करें। 

नोट: - विद्यार्थटयों को बताये सेंि बटन पर वक्लक करन ेकी जरूरत नहीं क्योकक ईमले 

भजेन ेके वलए इंटरनटे के्नक्सन होना जरूरी ह।ै 

33. To stop video time at 26 minutes 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 25 सकंेि। 

 

Stop video here and ask, if they know why we use ‘Export as PDF’ option 

विवियो को रोके और विद्यार्थटयों से पछूें क्या उन्ह ेयाद हैं की एक्सपोटट एज़ पीिीएफ़ का 

उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

34. To stop video time at 28 minutes 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 06 सकंेि। 

Stop video here and ask students to convert their file into pdf format as shown 

in the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों फ़ाइल को पीिीएफ़ मे बदलने को कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

35. To stop video time at 28 minutes 42 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 42 सकंेि। 

Stop video here and check whether they have converted their file into PDF or 

not and then play the video again. 

विवियो को रोके और चके करें की विद्यार्थटयों न ेफ़ाइल को पीिीएफ़ मे कन्िटट ककया है या 

नहीं और किर आगे विवियो को प्ले करें। 

36. To stop video time at 29 minutes 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 44 सकंेि। 

Stop video here and ask students to see the video and understand how to use 

‘Print directly’ option and then play the video again. 

विवियो को रोके और विद्यार्थटयों को विवियो दखे कर प्रटं िाइरेवक्लल विकल्प को समझने के 

वलए कहें और किर आगे विवियो प्ले करें। 

Note: - printer machine should be connected with they system for printing so 

there is no need to click on the ‘Print directly option’. 

नोट: -प्रटंटंग के वलए प्रंटर मशीन कनके्ट होना चावहए एवसवलए प्रटं िाइरेवक्लल विकल्प 

वक्लक करन ेकी जरूरत नहीं ह।ै 

37. To stop video time at 29 minutes 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 55 सकंेि। 

 

Stop video here and ask students can they use ‘Copy’, ‘Cut’ and ‘Paste’option? 

विवियो को रोके और विद्यार्थटयों से पछूें क्या आप कॉपी, कट और पसे्ट विकल्प का उपयोग 

कर सकत ेहैं। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

38. To stop video time at 31 minutes 10 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 10 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

39. To stop video time at 32 minutes 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 32 वमनट 26 सकंेि। 

 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें। 

Now just check whether they have used copy, cut and paste option or not and 

then play the video. 

अब चके करें विद्यार्थटयों ने कॉपी, कट और पसे्ट विकल्प का उपयोग ककया है या नहीं और 

किर आगे विवियो को प्ल ेकरें। 

40. To stop video time at 32 minutes 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 32 वमनट 30 सकंेि। 

 

Stop video here and ask why we use ‘Format paintbrush’? 

विवियो को रोके और विद्यार्थटयों से पछूें फ़ारमटै पेंटब्रश का उपयोग क्यों करत ेहैं? 
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Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

41. To stop video time at 33 minutes 29 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 29 सकंेि। 

Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों एक ऑब्जेक्ट ड्रॉ करन ेको कहें को जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

42. To stop video time at 34 minutes 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 34 वमनट 01 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

43. To stop video time at 35 minutes 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 35 वमनट 08 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें। 

Now just check whether they have used ‘Format paintbrush’ option or not and 

then play the video. 

अब चके करें विद्यार्थटयों ने फ़ारमटै पेंटब्रश विकल्प का उपयोग ककया ह ैया नहीं और किर 

आगे विवियो को प्ले करें। 

44. To stop video time at 35 minutes 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 35 वमनट 21 सकंेि। 

 

Stop video here and ask students can they use ‘Undo and Redo’option? 
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विवियो को रोके और विद्यार्थटयों से पछूें क्या आप अंिू और ररिू विकल्प का उपयोग कर 

सकत ेहैं। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

45. To stop video time at 36 minutes 28 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 28 सकंेि। 

Stop video here and ask students to remove the object by using ‘Undo’ option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को अिूं की मदद स ेऑब्जके्ट को हटाने को जसैा की 

विवियो मे कदखाया हैं और किर आगे विवियो को प्ले करें। 

46. To stop video time at 37 minutes 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 37 वमनट 16 सकंेि। 

Stop video here and ask students to bring back that object with help of ‘Redo’ 

which they had removed and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ररिू के द्वारा उस ऑब्जके्ट को िावपस लाये वजसे ररमिू 

ककया था और किर आग ेविवियो को प्ले करें। 

47. To stop video time at 38 minutes 04 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 38 वमनट 04 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें। 

Now just check whether they have used ‘Undo and Redo’ option or not and 

then play the video. 

अब चके करें विद्यार्थटयों ने अिूं और ररिू विकल्प का उपयोग ककया ह ैया नहीं और किर 

आगे विवियो को प्ले करें। 

48. To stop video time at 38 minutes 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 38 वमनट 43 सकंेि। 
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Stop video here and ask students, if they know what will we do to give the link 

of another document on slide. 

विवियो को रोके और विद्यार्थटयों से पछूें क्या आप जानत ेहै ककसी दसूरे िॉकयमुेंट का प्लकं 

स्लाइि पर दनेे के वलए क्या करेंग।े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

49. To stop video time at 40 minutes 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 40 वमनट 46 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

50. To stop video time at 41 minutes 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 41 वमनट 50 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें। 

Now just check whether they have used ‘Hyperlink’ option or not and then play 

the video. 

अब चके करें विद्यार्थटयों ने हाइपरप्लकं विकल्प का उपयोग ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

51. To stop video time at 42 minutes 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 42 वमनट 00 सकंेि। 

 

Stop video here and ask will you be able to draw a table? 

विवियो को रोके और पूछें क्या आप टेबल बना लेंग?े 

Just listen to the answers and play the video again for the correct answer. 
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जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

52. To stop video time at 42 minutes 42 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 42 वमनट 42 सकंेि। 

Stop video here and students to click on ‘Table’ option as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टेबल विकल्प पर वक्लक करन े को कहें जसैा की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

53. To stop video time at 43 minutes 37 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 43 वमनट 37 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा की विवियो मे कदखाया गया ह ैिसैा करन ेको कहें। 

Now just check whether they have drawn ‘Table’or not and then play the video. 

अब चके करें विद्यार्थटयों ने टेबल को ड्रॉ ककया ह ैया नहीं और किर आग ेविवियो को प्ले 

करें। 

54. To stop video time at 43 minutes 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 43 वमनट 44 सकंेि। 

 

Stop video here and ask what is ‘Display grid’ option? 

विवियो को रोके और पूछें विस्प्ले वग्रि स ेक्या होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

55. To stop video time at 45 minutes 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 45 वमनट 05 सकंेि। 

Stop video here and ask students to show and hide ‘Grid lines’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वग्रि लाईन को हाइि और अनहाइि करन ेको कहें जसैा 

की विवियो मे कदखाया और किर आगे विवियो को प्ले करें। 
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56. To stop video time at 45 minutes 11 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 45 वमनट 11 सकंेि। 

 

Stop video here and ask if they can hide and unhide ‘Standard toolbar’ option? 

विवियो को रोके और पूछें क्या आप स्टैंििट टूलबार के विकल्पो को हाइि और अनहाइि कर 

सकत ेहैं। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

57. To stop video time at 46 minutes 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 46 वमनट 54 सकंेि। 

Stop video here and ask students to hide ‘Standard toolbar option as shown in 

the video and then play the  video again. 

विवियो को रोके और विद्यावथयों को स्टैंििट टूलबार के विकल्प को हाइि करन ेको कहें जसैा 

की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

58. To stop video time at 47 minutes 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 वमनट 59 सकंेि। 

Stop video here and ask students to unhide ‘Standard toolbar’ option as shown 

in the video and then play the  video again. 

विवियो को रोके और विद्यावथयों को स्टैंििट टूलबार के विकल्प को अनहाइि करन ेको कहें 

जसैा की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

59. To stop video time at 49 minutes 56 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 49 वमनट 56 सकंेि। 

Stop video here and ask students to hide ‘Line and filling’option as shown in the 

video and then play the  video again. 

विवियो को रोके और विद्यावथयों को लाईन और किप्लगं के विकल्प को हाइि करन ेको कहें 

जसैा की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

60. To stop video time at 50 minutes 54 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 50 वमनट 54 सकंेि। 

Stop video here and ask students to unhide ‘Line and filling’option as shown in 

the video and then play the  video again. 

विवियो को रोके और विद्यावथयों को लाईन और किप्लगं के विकल्प को अनहाइि करन ेको 

कहें जसैा की विवियो म ेकदखाया गया है और किर आगे विवियो को प्ले करें। 

61. To stop video time at 51 minutes 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 51 वमनट 00 सकंेि। 

 

Stop video here and ask students to close their file and shout down the 

computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 

 

 

 

 

 

 

 

 

 

 

 

 

Complete teacher’s manual for Open office impress 2 Class 2 

Summaries 

 

 What is ‘Standard toolbar’? 

 Why we use ‘Standard toolbar’? 
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 How to take new slide by using ‘Standard toolbar’? 

 How to open any file with help of ‘Standard toolbar’? 

 How to convert text document file into a PDF file? 

 How to insert a table with help of ‘Standard toolbar? 

 Why we use ‘Fontwork’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to hide and unhide ‘Line and filling toolbar’?  

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

62. To stop video time at 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 सकंेि ।  

 

Stop video here and ask why we ‘Standard toolbar? 

विवियो को रोके और पछूें  स्टैंििट टूलबार का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

63. To stop video time at 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 सकंेि ।  
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Stop video here and ask how to hide and show standard toolbar? 

विवियो को रोके और पछूें  स्टैंििट टूलबार को कैसे हाइि और शो कैसे करत ेह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

64. To stop video time at 1 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 08 सकंेि । 

 

Stop video here and ask what is ‘Display Grid’? 

विवियो को रोके और पछूें विस्प्ले वग्रि क्या होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

65. To stop video time at 1 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 21 सकंेि । 

 

Stop video here and ask why we ‘Chart’? 

विवियो को रोके और पछूें  चाटट का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

66. To stop video time at 1 minute 40 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 40 सकंेि । 

 

Stop video here and ask do you know what is ‘Print file directly’? 

विवियो को रोके और पछूें  क्या आप जानत ेहैं प्रंट फ़ाइल िाइरैवक्टली? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

67. To stop video time at 1 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 52 सकंेि । 

 

Stop video here and ask students to open ‘Impress file’and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

68. To stop video time at 2 minute 04 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 04 सकंेि । 
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Stop video here and ask students to type the given paragraph on thr first slide 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को पहले स्लाइि मे कदये गये परैाग्राि को टाइप करन ेको 

कहें और किर आगे विवियो को प्ले करें। 

69. To stop video time at 2 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 13 सकंेि । 

Stop video here and ask students to formatting on the given paragraph as shown 

in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को परैाग्राि पर कदये गये विवियो के जसैा मे कदखाया गया 

है और किर आगे विवियो को प्ले करें। 

70. To stop video time at 3 minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 25 सकंेि । 

Stop video here and ask students to change the ‘Font style’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को िॉन्ट स्टाइल बदलन ेको कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

71. To stop video time at 4 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 40 सकंेि । 

Stop video here and ask students to do ‘Bold’ and ‘Underline’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को बोल्ि और अंिरलाईन करन ेको करन ेको कहें जसैे की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

72. To stop video time at 5 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 44 सकंेि । 

Stop video here and ask students to change the ‘Font color’ as shown in the 

video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को िॉन्ट कलर को बदलने को कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

73. To stop video time at 5 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 59 सकंेि । 

Stop video here and ask students to apply ‘Bullets’ on the line as shown in the 

video. 

विवियो को रोके और विद्यार्थटयों को लाईन पर बलुलेस लगाने को कहें जसैा की विवियो मे 

कदखाया गया ह।ै 

Now just check whether they have changed the formatting of paragraph or not 

and then play the video again. 

अब चके करें की विद्यार्थटयों ने परैाग्राि पर िोमटेटंग ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

74. To stop video time at 6 minute 09 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 09 सकंेि । 

 

Stop video here and ask how many methods to insert a new slide? 

 विवियो को रोके और पछूें न्यू स्लाइि को ककतन ेतरीके स ेसकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

75. To stop video time at 6 minute 49 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 49 सकंेि । 
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Stop video here and ask students to draw a rectangle and also ask to change the 

formatting of the recrtangle and then play the video again. 

विवियो को रोके और विद्यार्थटयों को रेक्टैंगल ड्रॉ करन ेको कहें और उसमे िोमटेटंग भी करन े

को कहें और किर आगे विवियो को प्ले करें। 

76. To stop video time at 7 minute 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 41 सकंेि । 

Stop video here and ask students to insert a new  blank slide as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक नयी ब्लैंक स्लाइि इन्सटट करन ेको कहें को जसैा की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

77. To stop video time at 8 minute 49 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 49 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

78. To stop video time at 9 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 06 सकंेि । 
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Stop video here and ask students to draw a table in slide and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को नयी स्लाइि पर एक टेबल बनान ेको कहें और किर आगे 

विवियो को प्ले करें। 

79. To stop video time at 10 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 12 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

80. To stop video time at 15 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 05 सकंेि । 

Stop video here and ask students to type the data in the table as shown in the 

video. 

विवियो को रोके और विद्यार्थटयों को टेबल मे िाटा टाइप करन ेको कहें जसैा की विवियो मे 

कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

81. To stop video time at 15 minute 11 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 11 सकंेि । 
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Stop video here and ask can you change the design of the table? 

विवियो को रोके और पछूें टेबल के विज़ाइन को कैस ेबदलते हैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

82. To stop video time at 16 minute 04 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 04 सकंेि । 

Stop video here and ask students to change the design of the table as shown in 

the video. 

विवियो को रोके और विद्यार्थटयों को टेबल के विज़ाइन बदलने को कहें जसैा की विवियो मे 

कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

83. To stop video time at 16 minute 19 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 19 सकंेि । 

 

Stop video here and ask students to insert a new slide and linked another 

document with help of ‘Hyperlink’ and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को एक नयी स्लाइि इन्सटट करन ेको कहें और उसपर 

हाइपरप्लकं की मदद स ेककसी दसूरे िॉकयुमेंट को प्लकं द ेऔर किर आगे विवियो को प्ले 

करें। 

84. To stop video time at 17 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 12 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

85. To stop video time at 18 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 22 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

86. To stop video time at 18 minute 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 58 सकंेि । 

Now just check whether they inserted ‘Hyperlink’ or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने हाइपरप्लकं को इन्सटट ककया ह ैया नहीं और किर आगे विवियो 

को प्ले करें। 

87. To stop video time at 19 minute 09 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 09 सकंेि । 

 

Stop video here and ask students to do ‘Copy’ and ‘Paste’ of slide number 3 and 

4 and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को स्लाइि नबंर 3 और 4 को कॉपी और पसे्ट करन ेको 

कहें और किर आगे विवियो को प्ले करें। 

88. To stop video time at 19 minutes 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 43 सकंेि । 

Stop video here and ask students to copy the slides as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को कॉपी  करन ेको कहें जसैा की विवियो मे कदखाया गया 

और किर आगे विवियो को प्ले करें। 

89. To stop video time at 20 minutes 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 15 सकंेि । 

Stop video here and ask students to ‘Paste’ which they had copied. 

विवियो को रोके और विद्यार्थटयों को पेस्ट करन ेको कहें वजसे विद्यार्थटयों न ेकॉपी ककया था। 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

90. To stop video time at 20 minutes 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 24 सकंेि । 

 

Stop video here and ask students to do ‘Undo’ and ‘Redo’ and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को अंिू करन ेको कहें और किर आगे विवियो को प्ले करें। 

91. To stop video time at 20 minutes 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 54 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

92. To stop video time at 21 minutes 30 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 30 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें। 

Now just check whether they have practiced of ‘Undo’ and ‘Redo’ or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने अिूं और ररिू का अभ्यास ककया या नहीं और किर आगे विवियो 

को प्ले करें। 

93. To stop video time at 21 minutes 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 43 सकंेि । 

 

Stop video here and ask students to hide some option of standard toolbars such 

as ‘New’, ‘Hyperlink’, ‘Display Grid’, ‘Copy and Paste’ and ‘Undo and Redo’ 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्टैंििट टूलबार के कुछ विकल्प जसैे की न्य,ू 

हाइपरप्लकं,विस्प्ले वग्रि, कॉपी और पसे्ट और अिूं और ररिू को हाईि करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

94. To stop video time at 22 minutes 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 39 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

95. To stop video time at 24 minutes 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 00 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें। 
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Now just check whether they have hidden of ‘these option’ or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने इस विकल्पो को हाईि ककया या नहीं और किर आगे विवियो को 

प्ले करें। 

96. To stop video time at 24 minutes 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 16 सकंेि । 

 
 

Stop video here and ask students to save their file to the ‘Desktop’ and then play 

the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल िसे्कटॉप पर सिे करन ेको कहें और किर आगे 

विवियो को प्ले करें। 

97. To stop video time at 24 minutes 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 16 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

98. To stop video time at 25 minutes 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 58 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें। 

Now just check whether they have saved their file or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने फ़ाइल सिे ककया या नहीं और किर आगे विवियो को प्ले करें। 

99. To stop video time at 26 minutes 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 03 सकंेि । 
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Stop video here and ask there are how many methods are there to convert ‘PDF’ 

file? 

विवियो को रोके और पूछें पीिीएफ़ फ़ाइल मे बदलने के वलए ककतन ेतरीके हैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें ।  

100. To stop video time at 27 minutes 27 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 27 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

101. To stop video time at 28 minutes 11 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 11 सकंेि । 

Now just check whether they have converted their file into PDF or not and play 

the video again. 

अब चके करें विद्यार्थटयों ने फ़ाइल को पीिीएफ़ म ेकन्िटट ककया या नहीं और किर आगे 

विवियो को प्ले करें। 

102. To stop video time at 28 minutes 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 26 सकंेि । 
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Stop video here and ask students to close their file and shout down the 

computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 
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Complete teacher’s manual for Open office impress 2 Class 3 

Summaries 

 

 How to create ‘Template’? 

 Why we use ‘Properties’ option? 

 How to send any document to another user? 

 Why we  use ‘Printer setting’ option? 

 How to insert a new slide? 

 Why we use ‘Preview in web browser’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 Why we use‘Line and filling toolbar’?  

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

103. To stop video time at 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 सकंेि ।  

 

Stop video here and ask if they know which options  cane be kept in ‘Standard 

toolbar’ ? 

विवियो को रोके और पछूें  स्टैंििट टूलबार के अदंर कौन कौन से विकल्पो को रख सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

104. To stop video time at 28 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 सकंेि ।  
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Stop video here and ask how to type in blank slide? 

विवियो को रोके और पछूें ब्लैंक स्लाइि मे टाइप कैस ेकरत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

105. To stop video time at 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 सकंेि । 

 

Stop video here and ask there are how many methods to insert a new slide? 

विवियो को रोके और पछूें  न्यू स्लाइि को ककतन ेतरीके स ेइन्सटट करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

106. To stop video time at 1 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 00 सकंेि । 
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Stop video here and ask what will they do to make more than one image of the 

same picture. 

विवियो को रोके और पछूें एक ही वचत्र की एक से ज्यादा कॉपी बनाने के वलए करेंग?े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

107. To stop video time at 1 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 15 सकंेि । 

 

Stop video here and ask students to open ‘Impress file’and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

108. To stop video time at 1 minute 37 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 37 सकंेि । 
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Stop video here and ask students to insert 3 slides and type the given paragraph 

on thr first slide and then play the video again. 

विवियो को रोके और विद्यार्थटयों को तीन स्लाइि इन्सटट करन ेको कहें और पहले स्लाइि मे 

कदये गये परैाग्राि को टाइप करन ेको कहें और किर आगे विवियो को प्ल ेकरें। 

109. To stop video time at 2 minute 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 58 सकंेि । 

Stop video here and ask students to insert any picture on the second slide as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को दसूरे स्लाइि मे कोई वचत्र को इन्सटट करन ेको कहें जसैे 

की विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें।  

110. To stop video time at 4 minute 33 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 33 सकंेि । 

Stop video here and ask students to draw a shape and also ask to do formatting 

in the drawing as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कोई शपे्स ड्रॉ करन ेको कहें और उसमे कोई िोमटेटंग 

भी करन ेको कहें जसैा की विवियो मे कदखाया ह ैऔर किर आगे विवियो को प्ले करें। 

111. To stop video time at 4 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 44 सकंेि । 
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Stop video here and tell students now we will learn about about ‘Wizard’ option 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को बोले अब हम विज़ािट विकल्प के बारे मे सीखेंगे और 

किर आगे विवियो को प्ल ेकरें। 

112. To stop video time at 5 minute 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 39 सकंेि । 

Stop video here and ask students to click on ‘File’ menu and then click ‘Wizard’ 

option and then they should select ‘Letter’ option as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें किर विज़ािट 

विकल्प पर वक्लक करन ेको कहें और किर लेटर विकल्प को वसलकै्ट करन ेको कहें जसैा की 

विवियो मे कदखाया गया हैं। 

113. To stop video time at 6 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 03 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

114. To stop video time at 6 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 50 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

115. To stop video time at 7 minute 37 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 37 सकंेि । 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

116. To stop video time at 8 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 10 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

117. To stop video time at 8 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 35 सकंेि । 

Now just check whether they have created‘Letter’ format or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने लटेर फ़ारमटै को तयैार ककया है या नहीं किर आगे विवियो को 

प्ले करें। 

118. To stop video time at 8 minute 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 48 सकंेि । 

Stop video here and tell students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Fax’ option as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें किर विज़ािट 

विकल्प पर वक्लक करन ेको कहें और किर फ़ैक्स विकल्प को वसलकै्ट करन ेको कहें जसैा की 

विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

119. To stop video time at 9 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 15 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

120. To stop video time at 10 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 03 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

121. To stop video time at 10 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 40 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

122. To stop video time at 11 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 02 सकंेि । 

Now just check whether they have created‘Fax’ format or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने फ़ैक्स फ़ारमटै को तयैार ककया है या नहीं किर आगे विवियो को 

प्ले करें। 

123. To stop video time at 11 minute 29 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 29 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

124. To stop video time at 12 minute 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 17 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

125. To stop video time at 13 minute 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 48 सकंेि । 

Now just check whether they have used ‘Wizard’ option or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने विज़ािट विकल्प का उपयोग ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

126. To stop video time at 13 minute 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 55 सकंेि । 
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Stop video here and ask why we use ‘Send’ option? 

विवियो को रोके और पूछें सेंि विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

127. To stop video time at 15 minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 25 सकंेि । 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Document as Email’ option as shown in the video and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें किर िॉकयमुेंट एज़ 

ईमले विकल्प पर वक्लक करन ेको कहें जसैा की विवियो मे कदखाया गया हैं और किर आगे 

विवियो को प्ले करें। 

128. To stop video time at 16 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 35 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

Note: -  tell students there is no need to click on ‘Send’ button since internet 

connection is required to send an email. 

विवियो को रोके और विद्यार्थटयों सेंि विकल्प का उपयोग करन ेको कहें जसैा की विवियो मे 

और किर आगे विवियो को प्ले करें। 

नोट: - विद्यार्थटयों को बताये सेंि बटन पर वक्लक करन ेकी जरूरत नहीं क्योकक ईमले 

भजेन ेके वलए इंटरनटे के्नक्सन होना जरूरी ह।ै 

129. To stop video time at 16 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 47 सकंेि । 
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Stop video here and ask what is ‘Properties’ option? 

विवियो को रोके और पूछें रोपटेीज़ विकल्प स ेक्या होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

130. To stop video time at 17 minute 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 38 सकंेि । 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Properties’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें किर रोपटेीज़ 

विकल्प पर वक्लक करन ेको कहें जसैा की विवियो मे कदखाया गया हैं और किर आगे विवियो 

को प्ले करें। 

131. To stop video time at 19 minute 27 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 27 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

132. To stop video time at 20 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 44 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

133. To stop video time at 20 minute 51 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 51 सकंेि । 
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Stop video here and ask what is ‘Printer setting’? 

विवियो को रोके और पूछें की प्रटंर सटेटंग से क्या होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

134. To stop video time at 21 minute 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 38 सकंेि । 

Stop video here and ask students to click on ‘File’ menu and then click ‘Printer 

setting’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें किर प्रटंर सटेटंग 

विकल्प पर वक्लक करन ेको कहें जसैा की विवियो मे कदखाया गया हैं और किर आगे विवियो 

को प्ले करें। 

135. To stop video time at 24 minute 16seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 16 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

136. To stop video time at 26 minute 04 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 04 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

137. To stop video time at 27 minute 28 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 28 सकंेि । 

Stop video here and ask students to do as shown in the video. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

138. To stop video time at 27 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 34 सकंेि । 

 

Stop video here and ask why we use ‘Template’ option? 

विवियो को रोके और पूछें टेंप्लटे विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

139. To stop video time at 28 minute 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 55 सकंेि । 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Template’ option and also ask to save the document as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें और किर टेंप्लटे 

विकल्प को वसलकै्ट करन ेको कहें और उस िॉकयमुेंट को सिे भी करन ेको कहें जसैे की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

140. To stop video time at 30 minute 19 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 19 सकंेि । 

Stop video here and ask students to ‘Export’ the document as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को िॉकयमुेंट को एक्सपोटट करन ेको कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

141. To stop video time at 30 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 54 सकंेि । 

Stop video here and ask students to do as shown in the video. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

142. To stop video time at 31 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 05 सकंेि । 

 

Stop video here and ask why we use ‘Preview in Browser’? 

विवियो को रोके और पूछें रीव्य ूइन िेबब्राउज़र का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

143. To stop video time at 33 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 00 सकंेि । 

Stop video here and ask students to use ‘Preview in web browser’ option as 

shown in video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को रीव्य ूइन िबेब्राउज़र का उपयोग करने को कहें जसैा की 

विवियो मे विकहया गया है और किर आगे विवियो को प्ले करें। 

144. To stop video time at 33 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 08 सकंेि । 
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Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Complete teacher’s manual for Open office impress 2 Class 4 
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Class 4 Summaries 

 

 How to create ‘Template’? 

 Why we use ‘Properties’ option? 

 How to send any document to another user? 

 Why we use ‘Printer setting’ option? 

 How to insert a new slide? 

 Why we use ‘Preview in web browser’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to show Standard toolbar? 

 Why we use‘Line and filling toolbar’?  

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

145. To stop video time at 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 सकंेि ।  

 

Stop video here and ask if they know what will they do for seeing slides on the 

web browser? 

विवियो को रोके और पछूें  क्या आप जानत ेहै स्लाइि को िबेब्राउज़र मे दखेन ेके वलए क्या 

करेंग?े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

146. To stop video time at 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 38 सकंेि ।  
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Stop video here and ask how to type in blank slide? 

विवियो को रोके और पछूें ब्लैंक स्लाइि मे टाइप कैस ेकरत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

147. To stop video time at 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 50 सकंेि । 

 

Stop video here and ask which option will be used for sending a document to 

the another user? 

विवियो को रोके और पछूें  िॉकयमुेंट को दसूरे यजूर को सेंि करन ेके वलए कौनस ेस ेविकल्प 

का उपयोग करेंग?े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

148. To stop video time at 1 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 03 सकंेि । 
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Stop video here and ask if they know where is the slide pane located in the 

‘Impress’ 

विवियो को रोके और पछूें क्या आप जानत ेहै इम्प्रसे मे स्लाइि पने  कहा होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

149. To stop video time at 1 minute 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 24 सकंेि । 

 

Stop video here and ask which option will be used to know all the information 

about ‘Impress’ 

विवियो को रोके और पछूें इम्प्रसे की सभी रकार की जानकारी के वलए कौन सा विकल्प का 

उपयोग करेंग?े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

150. To stop video time at 1 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 36 सकंेि । 
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Stop video here and ask students to open ‘Impress file’and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

151. To stop video time at 1 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 47 सकंेि । 

 

Stop video here and ask students to insert 3 slides and type the given paragraph 

on the first slide and then play the video again. 

विवियो को रोके और विद्यार्थटयों को तीन स्लाइि इन्सटट करन ेकहें और पहले स्लाइि मे कदये 

गये परैाग्राि को टाइप करन ेको कहें और किर आगे विवियो को प्ले करें। 

152. To stop video time at 3 minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 25 सकंेि । 

Stop video here and ask students to insert any picture on the second slide as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को दसूरे स्लाइि मे कोई वचत्र इन्सटट करने को कहें जसैा 

की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

153. To stop video time at 4 minute 20 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 20 सकंेि । 

Stop video here and ask students to draw any shape from ‘Drawing toolbar’ as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ड्राइंग टूलबार मे से कोई एक शेप ड्रॉ करन ेको कहें 

और किर आगे विवियो को प्ले करें। 

154. To stop video time at 5 minute 42 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 42 सकंेि । 

Stop video here and ask students to do the formatting on the shape as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को शेप मे िोमटेटंग करन ेको कहें जसै ेकी विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

155. To stop video time at 5 minute 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 48 सकंेि । 

 

Stop video here and ask students to do practice of ‘Send’ option and then play 

the video again. 

विवियो को रोके और विद्यार्थटयों को सेंि विकल्प का अभ्यास करन ेको कहें को और किर 

आगे विवियो को प्ले करें। 

156. To stop video time at 6 minute 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 58 सकंेि । 

Stop video here and ask students to click on the ‘File’ menu and select 

‘Document as email’ option and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें और किर िॉकयमुेंट 

एज़ ईमले का विकल्प को वसलकै्ट करन ेको कहें और किर आगे विवियो प्ले करें। 

157. To stop video time at 8 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 14 सकंेि । 

Stop video here and ask students to do as shown in the video. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

158. To stop video time at 8 minute 19 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 19 सकंेि । 

 

Stop video here and ask students to do practice of ‘Template’ option and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों को टेंप्लटे विकल्प का अभ्यास करन ेको कहें को और किर 

आगे विवियो को प्ले करें। 

159. To stop video time at 9 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 02 सकंेि । 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Template’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें और किर टेंप्लटे 

विकल्प को वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

160. To stop video time at 10 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 44 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

161. To stop video time at 11 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 26 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 
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Now just check whether they have made ‘Template’ or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने टेंप्लटे बनाया है या नहीं और किर आगे विवियो को प्ले करें। 

162. To stop video time at 11 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 35 सकंेि । 

 

Stop video here and ask students to create the ‘Fax’ format and the  play the 

video again. 

विवियो को रोके और विद्यार्थटयों को फ़ैक्स के फ़ारमैट को बनान ेको कहें और किर आगे 

विवियो को प्ले करें। 

163. To stop video time at 11 minute 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 55 सकंेि । 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Fax’ option of ‘Wizard’ as shown in the video and then play the again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें और किर विज़ािट के 

फ़ैक्स विकल्प को वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे 

विवियो प्ले करें। 

164. To stop video time at 12 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 50 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

165. To stop video time at 13 minute 49 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 49 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 
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Now just check whether they have Created ‘Fax format’ or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने फ़ैक्स फ़ारमटै को बनाया है या नहीं और किर आगे विवियो को 

प्ले करें। 

166. To stop video time at 13 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 52 सकंेि । 

 

Stop video here and ask students to do practice of ‘Printer setting’ option and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को प्रटंर सटेटंग विकल्प का अभ्यास करने को कहें को और 

किर आगे विवियो को प्ल ेकरें। 

167. To stop video time at 14 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 30 सकंेि । 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Printer setting’ option as shown in the video and then play the again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक करन ेको कहें और किर प्रटंर 

सटेटंग विकल्प को वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे 

विवियो प्ले करें। 

168. To stop video time at 16 minute 18 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 18 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

169. To stop video time at 19 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 05 सकंेि । 



   

 Supported By “Human Development Foundation” 57 
 
  
 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

170. To stop video time at 21 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 12 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have practiced ‘Printer setting’ option  or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने प्रटंर सटेटंग विकल्प का अभ्यास ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

171. To stop video time at 21 minute 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 17 सकंेि । 

 

Stop video here and ask students to do practice of ‘Preview in web browser’ 

and then play the video again. 

 

विवियो को रोके और विद्यार्थटयों को रीव्य ूइन िबे ब्राउज़र का अभ्यास करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

172. To stop video time at 22 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 47 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 
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Now just check whether they have practiced ‘Preview in web browser’ or not 

and play the video again. 

अब चके करें विद्यार्थटयों ने रीव्यू इन िबे ब्राउज़र का अभ्यास ककया ह ैया नहीं और किर 

आगे विवियो को प्ले करें। 

173. To stop video time at 22 minute 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 55 सकंेि । 

 

Stop video here and ask students to hide some options such as ‘Save’ ‘open’ and 

‘Hyperlink’ from ‘Standard toolbar’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्टैंििट टूलबार के कुछ विकल्प जसैे की सिे, ओपने और 

हाइपरप्लकं को हाईि करके कदखाया और किर आगे विवियो को प्ले करें। 

174. To stop video time at 24 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 16 सकंेि । 

Stop video here and ask students to unselect these options click on ‘OK’ button 

as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को इन विकल्पो को अनवसलकै्ट करन ेको कहें जसैे की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

175. To stop video time at 24 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 40 सकंेि । 
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Stop video here and ask students to draw their name on the slide with help of 

‘Fontwork’ option and also to do formatting on it and then play the video again. 

विवियो को रोके और विद्यार्थटयों िॉन्टिकट विकल्प की मदद स ेस्लाइि पर अपना नाम वलखन े

को कहें और उसमे िोमटेटंग करन ेको भी कहें और किर आगे विवियो को प्ले करें। 

176. To stop video time at 25 minute 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 46 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

177. To stop video time at 28 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 00 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

178. To stop video time at 29 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 21 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have practiced ‘Fontwork’ option or not and then 

play the video again. 

अब चके करें विद्यार्थटयों ने िॉन्टिकट विकल्प का अभ्यास ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

179. To stop video time at 29 minute 32 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 32 सकंेि । 

 

Stop video here and ask students to bring back those options which they had 

hidden and then play the video again. 

विवियो को रोके और विद्यार्थटयों को उन विकल्पो को िावपस लाने को कहें वजसे हाईि ककया 

था और किर आगे विवियो को प्ले करें। 

180. To stop video time at 30 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 59 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have got back those options or not and then play 

the video again. 

अब चके करें विद्यार्थटयों ने उन विकल्पो को िावपस लाये या नहीं और किर आगे विवियो को 

प्ले करें। 

181. To stop video time at 31 minute 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 07 सकंेि । 

 

Stop video here and ask students to close their file and shout down the 

computer. 
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विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Complete teacher’s manual for Open office impress 2 Class 5 
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Class 5 Summaries 

 

 Why we use ‘Points’ 

 Why we use ‘Glue points’ option? 

 Why we use ‘Field option’? 

 How to do any ‘Formatting on drawing? 

 How to insert a new slide? 

 How to use ‘Slide master’?  

 How to hide and unhide ‘Comments’? 

 How to insert comment? 

 What happens by ‘Navigator’ option? 

 Why we use ‘Zoom’ option? 

 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

182. To stop video time at 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 सकंेि ।  

 

Stop video here and ask why we use ‘Line and filling’ toolbar? 

विवियो को रोके और पछूें  लाईन और किप्लगं टूलबार का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

183. To stop video time at 2 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 31 सकंेि । 
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Stop video here and ask students to hide and unhide the ‘Slide pane’ as shown 

in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि पने हाइि और अनहाइि करन ेको कहें जसैा की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

184. To stop video time at 2 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 35 सकंेि । 

 

Stop video here and ask what is ‘Properties option? 

विवियो को रोके और पूछें रोपटेीज विकल्प स ेक्या होता ह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

185. To stop video time at 3 minute 09 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 09 सकंेि । 

 

Stop video here and ask there are how many methods to print ‘Impress file’? 

विवियो को रोके और पूछें इम्प्रसे फ़ाइल को ककतन ेतरीके से प्रंट कर सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

186. To stop video time at 3 minute 54 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 54 सकंेि । 

 

Stop video here and ask why we use ‘Templates’ option? 

विवियो को रोके और पूछें टेंपलटेस का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

187. To stop video time at 4 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 22 सकंेि । 

 
 

Stop video here and ask students to open ‘Impress file’and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

188. To stop video time at 4 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 54 सकंेि । 
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Stop video here and ask students to type the given paragraph on the first slide 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को पहल ेस्लाइि मे कदये गये परैाग्राि को टाइप करन ेको 

कहें और किर आगे विवियो को प्ले करें। 

189. To stop video time at 4 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 59 सकंेि । 

 

Stop video here and ask students if they have typed the paragraph? 

विवियो को रोके और विद्यार्थटयों से पछूें क्या आपने परैाग्राि टाइप कर वलया हैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

190. To stop video time at 5 minute 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 07 सकंेि । 

Stop video here and ask students to insert 10 ten slides. 

विवियो को रोके और विद्यार्थटयों 10 स्लाइि इन्सटट करन ेको कहें। 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

191. To stop video time at 5 minute 23 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 23 सकंेि । 

Stop video here and ask students to draw some shape and object from slide 

number 2 to 8 and also ask to do formatting on the these objects and then play 

the video again. 

विवियो को रोके और विद्यार्थटयों को 2 से 8 स्लाइि तक कुछ शपे्स या ऑब्जके्ट करन ेको 

कहें जसैा की विवियो म ेकदखाया गया है और किर आगे विवियो को प्ले करें। 

192. To stop video time at 9 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 34 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

193. To stop video time at 11 minute 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 39 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

194. To stop video time at 13 minute 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 24 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have drawn some shapes in slides numbers 2 to 8 

or not and play the video again. 

अब चके करें विद्यार्थटयों ने स्लाइि नबंर 2 से 8 तक कोई ड्राइंग बनाया है या नहीं और 

किर आगे विवियो को प्ल ेकरें। 

195. To stop video time at 13 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 34 सकंेि । 
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Stop video here and ask why use ‘Points’ option? 

विवियो को रोके और पूछें पॉइंलस विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

196. To stop video time at 14 minute 32 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 32 सकंेि । 

Stop video here and ask students to draw a line as shown in the video and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों को एक लाईन ड्रॉ करन ेको कहें जसैा की विवियो मे 

कदखाया गया है और किर आगे विवियो प्ले करें। 

197. To stop video time at 14 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 54 सकंेि । 

Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Points’ opiton as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एविट मनेू पर वक्लक करन ेको और किर पॉइंलस विकल्प 

को वसलकै्ट करें जसैा की विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

198. To stop video time at 16 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 02 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

199. To stop video time at 16 minute 27 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 27 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

200. To stop video time at 18 minute 37 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 37 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

201. To stop video time at 19 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 44 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

202. To stop video time at 19 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 52 सकंेि। 

 

Stop video here and ask why use ‘Glue Points’ option? 

विवियो को रोके और पूछें ग्लू पॉइंलस विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

203. To stop video time at 21 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 02 सकंेि। 

Stop video here and ask students to draw two shapes as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों 2 शपसे ड्रॉ करने को कहें जसैा की विवियो मे कदखाया गया 

है ओर किर आगे विवियो को प्ले करें। 
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204. To stop video time at 22 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 52 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

205. To stop video time at 24minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 25 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

206. To stop video time at 26 minutes 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 12 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

207. To stop video time at 26 minutes 19 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 19 सकंेि। 

 

Stop video here and ask why we use ‘Fields’ option? 

विवियो को रोके पूछें िील््स विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

208. To stop video time at 28 minutes 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 44 सकंेि। 
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Stop video here and ask students to insert ‘Date’, ‘Time’ and ‘Page number’ as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कदनाकं, समय और पज़े नबंर इन्सटट करन ेको कहें जसैे 

की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

209. To stop video time at 30 minutes 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 07 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

210. To stop video time at 31 minutes 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 24 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have changed formatting of ‘Fields’ or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने िील््स का िोमटेटंग बदला ह ैया नहीं और किर आगे विवियो 

को प्ले करें। 

211. To stop video time at 31 minutes 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 38 सकंेि। 

 

Stop video here and ask students if they remember what options they learnt in 

‘View menu’? 

विवियो को रोके और विद्यार्थटयों से पछूें क्या उनको याद है व्यू मने ूके कौन कौन से विकल्प 

के बारे मे सीखा था। 

212. To stop video time at 32 minutes 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 32 वमनट 02 सकंेि। 
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Stop video here and ask why we use ‘Slide master’? 

विवियो को रोके और पूछें स्लाइि मास्टर का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

213. To stop video time at 33 minutes 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 35 सकंेि। 

Stop video here and ask students to insert a slide and type some line in slide 

with some title as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक स्लाइि इन्सटट करन ेको कहें और स्लाइि टाइटल के 

साथ कुछ लाईन्स वलखन ेको कह ेजसैे की विवियो मे कदखाया गया और किर आगे विवियो 

को प्ले करें। 

214. To stop video time at 35 minutes 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 35 वमनट 17 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

215. To stop video time at 36 minutes 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 02 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have inserted 3 slides and typed some lines in 

these slides or not and play the video again. 

अब चके करें विद्यार्थटयों ने 3 स्लाइि इन्सटट ककया और उसमे कुछ टाइप ककया ह ैया नहीं 

और किर आगे विवियो को प्ले करें। 

216. To stop video time at 36 minutes 22 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 22 सकंेि। 

Stop video here and ask students to click on the ‘View menu’ and then select 

the ‘Slide master’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को व्यू मनेू पर वक्लक करन ेको कहें किर स्लाइि मास्टर 

को वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले 

करें। 

217. To stop video time at 37 minutes 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 37 वमनट 52 सकंेि। 

Stop video here and ask students to do formatting as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया िसैा िोमटेटंग करन ेको 

कहें और किर आगे विवियो को प्ले करें। 

218. To stop video time at 38 minutes 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 38 वमनट 44 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

219. To stop video time at 39 minutes 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 39 वमनट 50 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have used ‘Master slide’ or not and then play the 

video again. 

अब चके करें विद्यार्थटयों ने स्लाइि मास्टर का उपयोग ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

220. To stop video time at 39 minutes 57 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 39 वमनट 57 सकंेि। 
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Stop video here and ask why we use ‘Color and Grayscale’? 

विवियो को रोके और पूछें कलर और ग्रसे्केल का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

221. To stop video time at 40 minutes 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 40 वमनट 26 सकंेि। 

Stop video here and ask students to click on the ‘View menu’ and then select 

the ‘Colour and Greyscale’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को व्यू मनेू पर वक्लक करन ेको कहें किर कलर ग्रसे्केल को 

वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

222. To stop video time at 41 minutes 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 41 वमनट 48 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have Used ‘Color and Grayscale’ or not and play 

the video again. 

अब चके करें विद्यार्थटयों ने कलर और ग्रसे्केल का उपयोग ककया ह ैया नहीं और किर आगे 

विवियो को प्ले करें। 

223. To stop video time at 42 minutes 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 42 वमनट 39 सकंेि। 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Comment’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को इन्सटट मनेू पर वक्लक करन ेको कहें किर कॉमेंट विकल्प 

को वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले 

करें। 

224. To stop video time at 42 minutes 39 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 42 वमनट 39 सकंेि। 

Stop video here and ask students to type some lines in the ‘Comment box’ as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कॉमेंट बॉक्स मे कुछ टाइप करन ेको कहें और जसैा की 

विवियो मे कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

225. To stop video time at 44 minutes 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 40 सकंेि। 

Stop video here and ask students to hide and unhide the ‘Comment’ as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कॉमेंट विकल्प को हाइि और अनहाइि करन ेको कहें 

जसैा की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

226. To stop video time at 44 minutes 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 48 सकंेि। 

 

Stop video here and ask what is ‘Navigator’ and why we use it? 

विवियो को रोके और पुछें नवैिगटेर क्या है और उसका उपयोग क्यों करत ेह?ै 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

227. To stop video time at 45 minutes 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 45 वमनट 41 सकंेि। 

Stop video here and ask students to click on the ‘View’ menu’ and then select 

‘Navigator’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को व्यू मनेू पर वक्लक करन ेको कहें किर नवैिगटेर विकल्प 

को वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले 

करें। 

228. To stop video time at 46 minutes 32 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 46 वमनट 32 सकंेि। 
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Stop video here and ask students to move one slide to another with help of 

‘Navigator’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को नवैिगेटर की मदद स ेआप एक स्लाइि से दसूरे स्लाइि 

पर जाने को कहें और जसैे की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले 

करें। 

229. To stop video time at 47 minutes 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 वमनट 58 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have used ‘Navigator’ or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने नवैिगटेर विकल्प का उपयोग ककया ह ैया नहीं और किर आगे 

विवियो को प्ले करें। 

230. To stop video time at 48 minutes 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 48 वमनट 55 सकंेि। 

Stop video here and ask students to click on the ‘View’ menu’ and then select 

‘Zoom’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को व्यू मनेू पर वक्लक करन ेको कहें किर ज़मू विकल्प को 

वसलकै्ट करन ेको कहें जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

231. To stop video time at 49 minutes 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 49 वमनट 17 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

232. To stop video time at 49 minutes 51 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 49 वमनट 51 सकंेि। 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

233. To stop video time at 50 minutes 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 50 वमनट 25 सकंेि। 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

234. To stop video time at 52 minutes 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 52 वमनट 22 सकंेि। 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have used ‘Zoom’ or not and play the video again. 

अब चके करें विद्यार्थटयों ने ज़मू विकल्प का उपयोग ककया है या नहीं और किर आगे विवियो 

को प्ले करें। 

235. To stop video time at 52 minutes 33 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 52 वमनट 33 सकंेि। 

 

Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 
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Complete teacher’s manual for Open office impress 2 Class 6 

Summaries 

 

 Why we use ‘Points’ 

 Why we use ‘Glue points’ option? 

 Why we use ‘Field option’? 

 How to do any ‘Formatting on drawing? 

 How to insert a new slide? 

 How to use ‘Slide master’?  

 How to hide and unhide ‘Comments’? 

 How to insert comment? 

 What happens by ‘Navigator’ option? 

 Why we use ‘Zoom’ option? 

 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

236. To stop video time at 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 सकंेि ।  
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Stop video here and ask which shortcut command will used for ‘Slide show’? 

विवियो को रोके और पछूें  स्लाइि शो के वलए कौन सी शॉटटकट कमािं का उपयोग करेंग?े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

237. To stop video time at 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 सकंेि ।  

238. To stop video time at 1 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 00 सकंेि । 

 

Stop video here and ask if slide view has been changed, how to bring back in 

normal view? 

विवियो को रोके और पछूें अगर स्लाइि का व्यू बादल गया हो तो उसे नॉमटल व्यू मे िावपस 

केस ेलाएाँग?े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

239. To stop video time at 1 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 16 सकंेि । 
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Stop video here and ask why we use ‘Fields’ option? 

विवियो को रोके और पछूें िील््स विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

240. To stop video time at 1 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 31 सकंेि । 

 

Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

241. To stop video time at 1 minute 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 43 सकंेि । 
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Stop video here and ask what did they learn in previous class? 

विवियो को रोके और पूछें वपछली क्लास मे क्या सीखा? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

242. To stop video time at 1 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 59 सकंेि । 

 

Stop video here and ask students to insert 4 slides and type the given paragraph 

on the first slide and then play the video again. 

विवियो को रोके और विद्यार्थटयों को चार स्लाइि इन्सटट करन ेकहें और पहले स्लाइि मे कदये 

गये परैाग्राि को टाइप करन ेको कहें और किर आगे विवियो को प्ले करें। 

243. To stop video time at 2 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 06 सकंेि । 



   

 Supported By “Human Development Foundation” 81 
 
  
 

 

Stop video here and ask students to change their name style with help of ‘Font 

work’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को िॉन्टिकट की मदद स ेनाम के स्टाइल को बदल के 

कदखाये और किर आगे विवियो को प्ले करें। 

244. To stop video time at 2 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 47 सकंेि । 

Stop video here and ask students to insert slides as shown in the video and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों स्लाइि इन्सटट करने को कहें को जसैा की विवियो मे कदखाया 

गया और किर आगे विवियो को प्ले करें। 

245. To stop video time at 3 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 54 सकंेि । 

Stop video here and ask students to select any ‘Font work’ style as shown in the 

video and then play the video again.  

विवियो को रोके और विद्यार्थटयों को िॉन्टिकट स्टाइल मे स ेकोई एक स्टाइल को वसलकै्ट 

करन ेको जसै ेकी विवियो मे कदखाया गया और किर आगे विवियो को प्ल ेकरें। 

246. To stop video time at 5 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 20 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

247. To stop video time at 6 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 13 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 
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Now just check whether they have used ‘Font work’ or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने िॉन्टिकट का उपयोग ककया ह ैया नहीं और किर आगे विवियो को 

प्ले करें। 

248. To stop video time at 6 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 22 सकंेि । 

 

Stop video here and ask them if they know how many ways one can view slide? 

विवियो को रोके और  विद्यार्थटयों से पछूें क्या आप जानत ेहैं स्लाइि को ककतन ेतरीके स ेदखे 

सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

249. To stop video time at 6 minute 37 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 37 सकंेि । 

Stop video here and ask students to practice these options and then play the 

video again. 

विवियो को रोके और  विद्यार्थटयों को इन विकल्पो का अभ्यास करन ेको कहें और किर आगे 

विवियो को प्ले करें। 

250. To stop video time at 7 minute 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 45 सकंेि । 

Stop video here and ask students to practice these options and then play the 

video again. 

विवियो को रोके और  विद्यार्थटयों को इन विकल्पो का अभ्यास करन ेको कहें और किर आगे 

विवियो को प्ले करें। 

251. To stop video time at 9 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 30 सकंेि । 

Stop video here and ask students to do as shown in the video. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have changed the view of the slides or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने स्लाइिस का व्यू बदला है या नहीं और किर आगे विवियो को 

प्ले करें। 

252. To stop video time at 9 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 40 सकंेि । 

Stop video here and ask students to insert ‘Comments’ on the slide and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइिस पर कॉमेंट लगान ेको कहें और किर आगे 

विवियो को प्ले करें। 

253. To stop video time at 11 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 03 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

254. To stop video time at 12 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 10 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have hidden the comments or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने कोमेंलस को हाइि ककया है या नहीं और किर आगे विवियो को 

प्ले करें। 

255. To stop video time at 12 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 21 सकंेि । 



   

 Supported By “Human Development Foundation” 84 
 
  
 

 

Stop video here and ask how to see the picture in the slide and how to move 

from one picture to another? 

विवियो को रोके और पूछें स्लाइि के वचत्र को कैस ेदखेेंगे और एक वचत्र स ेदसूरे वचत्र को पर 

कैस ेआएगं।े 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

256. To stop video time at 13 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 06 सकंेि । 

Stop video here and ask students to click on the ‘View menu’ and then select 

the ‘Navigator’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें व्य ूमने ूपर वक्लक करन ेको कहें और किर नवैिगेटर 

विकल्प को वसलकै्ट करन ेको कहें जसैा की विवियो मे कदखाया गया है और किर आगे 

विवियो को प्ले करें। 

257. To stop video time at 14 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 44 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have practiced ‘Navigator’ option or not and then 

play the video again. 

अब चके करें विद्यार्थटयों ने नवैिगटेर विकल्प का अभ्यास ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

258. To stop video time at 14 minute 56 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 56 सकंेि । 

Stop video here and ask students to show ‘Comment’ which they had hidden 

and type ‘Computer Shiksha’ in the comment box and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को कॉमेंट शो करन ेको वजसे हाइि ककया था और उसमे 

कम्प्प्यटुर वशक्षा टाइप करने को कहें और किर आग ेविवियो को प्ले करें। 

259. To stop video time at 15 minute 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 46 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have shown the ‘Comment’ or not and then play 

the video again. 

अब चके करें विद्यार्थटयों ने कॉमेंट को शो है या नहीं और किर आगे विवियो को प्ले करें। 

260. To stop video time at 15 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 52 सकंेि । 

 

Stop video here and ask students to practice ‘Slide master’ and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि मास्टर का अभ्यास करन ेको कहें जसैा की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ल।े 

261. To stop video time at 16 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 34 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

262. To stop video time at 18 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 30 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

263. To stop video time at 20 minute 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 07 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

264. To stop video time at 20 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 54 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have practiced ‘Master slide’ or not and then play 

the video again. 

अब चके करें विद्यार्थटयों ने मास्टर स्लाइि का अभ्यास ककया ह ैया नहीं और किर आगे 

विवियो को प्ले करें। 

265. To stop video time at 21 minute 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 01 सकंेि । 

Stop video here and ask students to hide the ‘Side bar’ and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को हाइि करन ेको कहें और किर आगे विवियो को प्ले करें। 

266. To stop video time at 22 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 20 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have practiced the ‘Sidebar’option or not and play 

the video again. 

अब चके करें विद्यार्थटयों ने साइिबार के विकल्प का अभ्यास ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

267. To stop video time at 22 minute 29 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 29 सकंेि । 

Stop video here and ask students to hide ‘Line and filling, ‘Drawing bar’ and 

‘Standard toolbar’ and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को लाईन और किप्लगं, ड्राइंग बार और स्टैंििट टूलबार को 

हाइि करन ेको कहें और किर आगे विवियो को प्ले करें। 

268. To stop video time at 23 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 08 सकंेि । 

Stop video here and ask students to hide ‘Drawing toolbar’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ड्राइंग टूलबार हाइि करन ेको कहें जसैे की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

269. To stop video time at 24 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 06 सकंेि । 

Stop video here and ask students to hide ‘Line and filling’ toolbar’ and 

‘Standard toolbar’ as shown in the video. 

विवियो को रोके और विद्यार्थटयों को लाईन और किप्लगं और स्टैंििट टूलबार को हाइि करन ेको 

कहें जसैे की विवियो मे कदखाया गया ह।ै  

Now just check and play the video again. 

अब चके करे और किर आगे विवियो को प्ले करें। 

270. To stop video time at 24 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 12 सकंेि । 

 

Stop video here and ask students to show ‘Standard toolbar’, ‘Line and filling’ 

and ‘Drawing toolbar’ then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्टैंििट टूलबार, लाईन और किप्लंग और ड्राइंग टूलबार 

को शो करन ेको कहें और किर आगे विवियो को प्ले करें। 

271. To stop video time at 24 minute 51 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 51 सकंेि । 

Stop video here and ask students to show ‘Drawing toolbar’ as shown in the 

video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को ड्राइंग टूलबार शो करन ेको कहें जसै ेकी विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

272. To stop video time at 26 minute 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 01 सकंेि । 

Stop video here and ask students to do show ‘Line and filling’ toolbar’ and 

‘Standard toolbar’ as shown in the video. 

विवियो को रोके और विद्यार्थटयों को लाईन और किप्लगं और स्टैंििट टूलबार को शो करन ेको 

कहें जसैे की विवियो मे कदखाया गया ह।ै  

Now just check and play the video again. 

अब चके करे और किर आगे विवियो को प्ले करें। 

273. To stop video time at 26 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 10 सकंेि । 

Stop video here and ask students to draw two objects and join them with help of 

‘Glue points’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को दो ऑब्जके्ट ड्रॉ करन ेको कहें और किर ग्लू पॉइंलस की 

मदद स ेदोनों ऑब्जके्ट को जोड़े और किर आगे विवियो को प्ले करें। 

274. To stop video time at 26 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 52 सकंेि । 

Stop video here and ask students to draw two objects as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को दो ऑब्जके्ट ड्रॉ करन ेको कहें जसैे की विवियो मे कदखाया 

गया और किर विवियो को प्ले करें। 

275. To stop video time at 28 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 15 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have practiced ‘Glue points’ or not and then play 

the video again. 

अब चके करें विद्यार्थटयों ने ग्ल ूपॉइंलस का अभ्यास ककया ह ैया नहीं और किर आगे विवियो 

को प्ले करें। 

276. To stop video time at 28 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 21 सकंेि । 

Stop video here and ask students to draw a line and use ‘Points in this line and 

then play the video again. 
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विवियो को रोके और विद्यार्थटयों को लाईन द्रि करने को कहें और उसमे पॉइंलस का उपयोग 

करन ेको कहें और किर आगे विवियो को आगे विवियो को प्ले करें। 

277. To stop video time at 29 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 10 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

278. To stop video time at 29 minute 57 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 57 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

279. To stop video time at 30 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 16 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they practiced ‘Points’ or not and play the video again. 

अब चके करें विद्यार्थटयों ने पॉइंलस विकल्प का अभ्यास ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

280. To stop video time at 30 minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 25 सकंेि । 

 

Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 
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Complete teacher’s manual for Open office Impress 2 Class 7 

Class 7 Summaries 

 

 Why we use ‘Expand and summary slide’ ? 

 Why we use ‘animated image’ option ? 

 Why we use ‘Movie and sound’ ? 

 What is ‘object’ and ‘chart’ option ? 

 Why we use ‘position and size’ ? 

 Why we use ‘line’ option ? 

 What is area option ? 

 How to crop a picture ? 

 How to use style and formatting? 

 How to correct spelling? 

 How to change language ? 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

281. To stop video time at 23 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 सकंेि ।  
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Stop video here and ask what did they learn in previous class? 

विवियो को रोके और पछूें  वपछली क्लास मे क्या सीखा था? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

282. To stop video time at 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 38 सकंेि ।  

 

Stop video here and ask what they had learnt in ‘Standard toolbar’ option? 

विवियो को रोके और पछूें स्टैंििट टूलबार मे क्या सीखा था? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

283. To stop video time at 1 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 00 सकंेि । 
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Stop video here and ask how to hide ‘Grid’ from ‘Impress file’? 

विवियो को रोके और पछूें इम्प्रसे की फ़ाइल स ेवग्रि को कैसे हाइि करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

284. To stop video time at 1 minute 32 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 32 सकंेि । 

 

Stop video here and ask why we use ‘Points’ option? 

विवियो को रोके और पछूें पॉइंलस विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

285. To stop video time at 1 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 54 सकंेि । 
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Stop video here and ask why we use ‘Fields’ option? 

विवियो को रोके और पछूें िील््स विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

286. To stop video time at 2 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 15 सकंेि । 

 

Stop video here and ask why we use ‘Hyperlink’ option? 

विवियो को रोके और पछूें हाइपरप्लकं विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

287. To stop video time at 2 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 31 सकंेि । 
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Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

288. To stop video time at 3 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 31 सकंेि । 

 

Stop video here and ask students to type the given paragraph on the slide and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि मे कदये गये परैाग्राि को टाइप करने को कहें 

और किर आगे विवियो को प्ले करें। 

289. To stop video time at 3 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 35 सकंेि । 

Stop video here and check whether they have typed paragraph or not and then 

play the video again. 

विवियो को रोके और चके करें विद्यार्थटयों न ेपरैाग्राि टाइप ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

290. To stop video time at 3 minute 48 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 48 सकंेि । 

 

Stop video here and ask why we use ‘Summary slide’ option? 

विवियो को रोके और पछूें समरी स्लाइि विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

291. To stop video time at 5 minute 23 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 23 सकंेि । 

Stop video here and ask students to insert a slide and then give the title and also 

draw an object as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक स्लाइि इन्सटट करन ेको और उसमे कोई टाइटल द े

और एक ऑब्जके्ट भी ड्रॉ करन ेको कहें जसैे की विवियो मे कदखाया  गया है और किर आगे 

विवियो को प्ल।े 

292. To stop video time at 6 minute 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 07 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

293. To stop video time at 6 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 16 सकंेि । 
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Stop video here and ask why we use ‘Expand slide’ option? 

विवियो को रोके और पछूें एकस्पेंि विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

294. To stop video time at 6 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 16 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have applied Expand slide or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने एकस्पेंि स्लाइि लगाया है या नहीं और किर आगे विवियो को 

प्ले करें। 

295. To stop video time at 7 minute 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 43 सकंेि । 

 

Stop video here and ask why we use ‘Animated image’ option? 
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विवियो को रोके और पछूें अवनमटेि इमजे विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

296. To stop video time at 8 minute 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 43 सकंेि । 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Animated image’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को इन्सटट मनेू पर वक्लक करन ेको कहें और किर अवनमटेेि 

इमजे पर वक्लक करन ेको कहें जसैे की विवियो को प्ले करें और किर आग ेविवियो को प्ले 

करें। 

297. To stop video time at 9 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 16 सकंेि । 

Stop video here and ask students to insert a picture and click on the apply object 

as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक वचत्र को इन्सटट करन ेको कहें और किर अप्लाई 

ऑब्जके्ट पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

298. To stop video time at 10 minute 32 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 32 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

299. To stop video time at 12 minute 29 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 29 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

300. To stop video time at 13 minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 25 सकंेि । 

Stop video here and ask students to click on ‘Insert menu’ and then click on the 

‘Movie and Sound’ as shown in the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को इन्सटट मनेू पर वक्लक करन ेको कहें और किर मिूी और 

साउंि विकल्प पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे 

विवियो प्ले करें। 

301. To stop video time at 14 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 02 सकंेि । 

Stop video here and ask students to insert any video as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को कोई विवियो इन्सटट करन ेको कहें जसैे की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

302. To stop video time at 15 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 26 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

303. To stop video time at 15 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 31 सकंेि । 

 

Stop video here and ask why we use ‘Object’ option? 

विवियो को रोके और पछूें ऑब्जेक्ट विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

304. To stop video time at 16 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 52 सकंेि । 

Stop video here and ask students to click on the ‘Insert menu’ and then click on 

‘Object’ as shown in the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को इन्सटट मनेू पर वक्लक  करन ेको कहें और किर ऑब्जके्ट 

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

305. To stop video time at 18 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 03 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

306. To stop video time at 20 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 00 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

307. To stop video time at 21 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 40 सकंेि । 

Stop video here and ask students to draw an object and also ask to copy and 

paste as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक ऑब्जके्ट ड्रॉ करन ेको कहें और किर उस ेकॉपी और 

पेस्ट करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें।

  

308. To stop video time at 21 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 50 सकंेि ।  

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Position and size’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक करन ेको कहें और किर पोवजसन 

और साईज़ विकल्प पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर 

आगे विवियो प्ले करें। 

309. To stop video time at 23 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 12 सकंेि ।  

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

310. To stop video time at 26 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 15 सकंेि ।  

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

311. To stop video time at 27 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 10 सकंेि ।  

Stop video here and ask students to draw a ‘Line’ as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक लाईन ड्रॉ करन ेको कहें जसै ेकी विवियो मे कदखाया 

गया ह ैऔर किर आगे विवियो को प्ले करें। 

312. To stop video time at 27 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 36 सकंेि ।  

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Line’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक करन ेको कहें और किर लाईन  

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

313. To stop video time at 29 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 14 सकंेि ।  

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

314. To stop video time at 31 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 34 सकंेि ।  

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

315. To stop video time at 31 minute 43 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 31 वमनट 43 सकंेि ।  

 

Stop video here and ask why we use ‘Area’ option? 

विवियो को रोके और पछूें एररया विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

316. To stop video time at 32 minute 42 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 32 वमनट 42 सकंेि ।  

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Area’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक  करन ेको कहें और किर एररया 

विकल्प पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

317. To stop video time at 33 minute 28 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 28 सकंेि ।  

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

318. To stop video time at 35 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 35 वमनट 16 सकंेि ।  

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

319. To stop video time at 38 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 38 वमनट 40 सकंेि । 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

320. To stop video time at 39 minute 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 39 वमनट 38 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

321. To stop video time at 39 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 39 वमनट 44 सकंेि । 

 

Stop video here and ask what is ‘Text’ option? 

विवियो को रोके और पछूें टेक्स्ट विकल्प से क्या होता हैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

322. To stop video time at 40 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 40 वमनट 40 सकंेि । 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Text’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक  करन ेको कहें और किर टेक्स्ट 

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

323. To stop video time at 41 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 41 वमनट 12 सकंेि । 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

324. To stop video time at 43 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 43 वमनट 02 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

325. To stop video time at 44 minute 04 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 04 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

326. To stop video time at 44 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 10 सकंेि । 

Stop video here and ask why we ‘Crop picture’? 

विवियो को रोके और क्रॉप वपक्चर का उपयोग क्यों करत ेहैं? 

 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

327. To stop video time at 45 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 45 वमनट 14 सकंेि । 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Crop picture’ as shown in the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक  करन ेको कहें और किर क्रॉप 

वपक्चर पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

328. To stop video time at 46 minute 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 46 वमनट 01 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

329. To stop video time at 47 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 वमनट 31 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have used ‘Crop picture’ or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने क्रॉप वपक्चर का उपयोग ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

330. To stop video time at 48 minute 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 48 वमनट 17 सकंेि । 

Stop video here and ask students to click on the ‘Format’ and then click on 

‘Style and formatting’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक  करन ेको कहें और किर स्टाइल 

और िोमटेटंग पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया ह ैऔर किर आगे 

विवियो प्ले करें। 

331. To stop video time at 48 minute 53 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 48 वमनट 53 सकंेि । 

Stop video here and ask students to change the background color of the slide as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि का बकॅग्राउंि कलर बदलन ेको कहें जसैे की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

332. To stop video time at 50 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 50 वमनट 13 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

333. To stop video time at 51 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 51 वमनट 13 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have used ‘Formatting and style’ or not and play 

the video again. 

अब चके करें विद्यार्थटयों ने िोमटेटंग और स्टाइल का उपयोग ककया ह ैया नहीं और किर 

आगे विवियो को प्ले करें। 

334. To stop video time at 51 minute 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 51 वमनट 41 सकंेि । 

 

Stop video here and ask what is ‘Color replacer’ option? 

विवियो को रोके और पछूें कलर ररप्लसेर विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

335. To stop video time at 52 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 52 वमनट 44 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Color replacer’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर कलर 

ररप्लसेर पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

336. To stop video time at 54 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 54 वमनट 22 सकंेि । 

Stop video here and ask students to do as shown in the video. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have replaced the picture’s color or not and play 

the video again. 

अब चके करें विद्यार्थटयों ने वपक्चर के कलर को ररप्लसे ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

337. To stop video time at 55 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 55 वमनट 08 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Media player’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ारमटै मने ूपर वक्लक करन ेको कहें और किर मीविया 

प्लयेर पर वक्लक करन ेको कहें जसैे की विवियो म ेकदखाया गया है और किर आगे विवियो 

प्ले करें। 

338. To stop video time at 55 minute 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 55 वमनट 43 सकंेि । 

Stop video here and ask students to insert any video as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को कोई विवियो इन्सटट करन ेको कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

339. To stop video time at 57 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 57 वमनट 26 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have inserted any video or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने विवियो को इन्सटट ककया है या नहीं और किर आगे विवियो को 

प्ले करें। 

340. To stop video time at 57 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 57 वमनट 31 सकंेि । 
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Stop video here and ask why we use ‘Minimize presentation’ option? 

विवियो को रोके और पछूें वमवनमाइज़ रजेेंटेशन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

341. To stop video time at 58 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 58 वमनट 22 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Minimize presentation’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर 

वमवनमाइज़ रजेेंटेशन पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर 

आगे विवियो प्ले करें। 

342. To stop video time at 59 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 59 वमनट 12 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

343. To stop video time at 59 minute 12 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 59 वमनट 12 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have used ‘Minimize presentation’ or not and play 

the video again. 

अब चके करें विद्यार्थटयों ने वमवनमाइज़ रजेेंटेशन का उपयोग ककया ह ैया नहीं और किर आगे 

विवियो को प्ले करें। 

344. To stop video time at 1 Hour 00 minute 23 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 घटंा 00 वमनट 23 सकंेि । 

 

Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 
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Complete teacher’s manual for Open office Impress 2 Class 8 

Summaries 

 

 Why we use ‘Expand and summary slide’ ? 

 Why we use ‘animated image’ option ? 

 Why we use ‘Movie and sound’ ? 

 What is ‘object’ and ‘chart’ option ? 

 Why we use ‘position and size’ ? 

 Why we use ‘line’ option ? 

 What is area option ? 

 How to crop a picture ? 

 How to use style and formatting? 

 How to correct spelling? 

 How to change language ? 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

345. To stop video time at 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 सकंेि ।  

 

Stop video here and ask if they remember what they learnt in previous class ? 

विवियो को रोके और पछूें  क्या आपको याद हैं की आपने वपछली कक्षा मे क्या सीखा था ? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

346. To stop video time at 36 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 सकंेि ।  

 

Stop video here and ask what is ‘animated image’  ? 

विवियो को रोके और पछूें  ‘अवनमटेि इमजे’ क्या होता ह ै? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

347. To stop video time at 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 58 सकंेि ।  

 

Stop video here and ask which option is used to ‘play MP3 or video’ file in 

impress slide  ? 

विवियो को रोके और पछूें इम्प्रसे की स्लाइि पर ‘एमपी3 या विवियो के फ़ाइल को प्ल’े 

करना हो तो कौन स ेविकल्प का उपयोग करेंगे ?  

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

348. To stop video time at 1 minute 18 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 18 सकंेि ।  
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Stop video here and ask if we can cut picture using ‘crop picture’ option or not  

? 

विवियो को रोके और पछूें ‘क्रॉप वपक्चर’ से वचत्र को कट कर सकत ेहै या नहीं ?  

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

349. To stop video time at 1 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 40 सकंेि ।  

 

Stop video here and ask what is shortcut command for ‘spelling’ ?  

विवियो को रोके और पछूें ‘स्पपे्लंग’ के वलए शॉटटकट कमािं की क्या होती है ?   

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

350. To stop video time at 1 minute 56 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 56 सकंेि ।  
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Stop video here and ask where are ‘text, area, line and styles and formatting’ 

options ?  

विवियो को रोके और पछूें  ‘टेक्स्ट, एररया, लाइन और स्टाइल & िोमटेटंग’ विकल्प कहा 

आते ह ै?   

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

351. To stop video time at 2 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 10 सकंेि ।  

 

Stop video here and ask what is ‘’color replacer’ ?  

विवियो को रोके और पछूें  ‘कलर ररप्लसेर’ क्या होता है ?   

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

352. To stop video time at 2 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 26 सकंेि ।  
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Stop video here and ask why we use ‘minimize presentation’?  

विवियो को रोके और पछूें  ‘वमनीमाइज़ रजेेंटसन’ का उपयोग क्यों करत ेहै ?   

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

353. To stop video time at 2 minute 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 48 सकंेि ।  

 

Stop video here and ask why we use ‘wizard’ option in file menu?  

विवियो को रोके और पछूें  फ़ाइल मनेू के ‘विज़ािट’ विकल्प का उपयोग क्यों करत ेह ै?   

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

354. To stop video time at 3 minute 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 07 सकंेि ।  
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Stop video here and ask students to turn on their computer and open ‘Impress 

file’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कम्प्प्यटुर को ऑन करें और इम्प्रसे की फ़ाइल को ओपने 

करन ेको कहें और किर आगे विवियो को प्ले करें। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

355. To stop video time at 3 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 20 सकंेि । 

 

Stop video here and ask students to insert slides and type the given paragraph on 

the first slide and then play the video again. 

विवियो को रोके और विद्यार्थटयों को चार स्लाइि इन्सटट करन ेकहें और पहले स्लाइि मे कदये 

गये परैाग्राि को टाइप करन ेको कहें और किर आगे विवियो को प्ले करें। 

356. To stop video time at 3 minute 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 45 सकंेि । 

Stop video here and ask students to select the line as shown in the video and 

then play the video again. 
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विवियो को रोके और विद्यार्थटयों को इस लाइन को सलेके्ट करन ेको कहें को जसैा की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

357. To stop video time at 4 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 13 सकंेि । 

Stop video here and ask students to do ‘copy & paste’  as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘कॉपी & पसे्ट’ करने को कहें जसैा की विवियो मे 

कदखाया गया किर आगे विवियो को प्ले करें। 

358. To stop video time at 4 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 20 सकंेि । 

 

Stop video here and ask students to insert slides and do the practice of  ‘movie 

and sound’ option as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  स्लाइि इन्सटट करन ेको कहें और ‘मिूी और साउंि’ 

विकल्प का अभ्यास करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘Movie and sound’ option  or not 

and play the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘मिूी और साउंि’ विकल्प का अभ्यास ककया है या नहीं और 

किर सही उत्तर के वलए आगे के विवियो को प्ले करें। 

359. To stop video time at 5 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 00 सकंेि । 

Stop video here and ask students to insert slides as shown in the video and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों स्लाइि इन्सटट करने को कहें को जसैा की विवियो मे कदखाया 

गया और किर आगे विवियो को प्ले करें। 

360. To stop video time at 5 minute 59 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 59 सकंेि । 

Stop video here and ask students to select ‘Movie and sound’ option as shown 

in the video and then play the video again.  

विवियो को रोके और विद्यार्थटयों को ‘मूिी और साउंि’ विकल्प को सलेके्ट करन ेको जसैे की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

361. To stop video time at 6 minute 53 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 53 सकंेि । 

Stop video here and ask students to select ‘file from here’ and do as shown in 

the video and then play the video again.  

विवियो को रोके और विद्यार्थटयों को यहााँ स े‘फ़ाइल को सलेके्ट करने को कहें और िसैा करें 

जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘movie and sound’ or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने ‘मिूी और साउंि’ का उपयोग ककया ह ैया नहीं और किर आगे 

विवियो को प्ले करें। 

362. To stop video time at 7 minute 19 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 19 सकंेि । 

 

Stop video here and ask students to insert slides and do the practice of  

‘summary slide’ option as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  स्लाइि इन्सटट करन ेको कहें और ‘समरी स्लाइि’ 

विकल्प का अभ्यास करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘summary slide’ option or not and 

play the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘समरी स्लाइि’ विकल्प का अभ्यास ककया ह ैया नहीं और किर 

सही उत्तर के वलए आगे के विवियो को प्ले करें। 
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363. To stop video time at 8 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 20 सकंेि । 

Stop video here and ask students to insert slides and do as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों स्लाइि इन्सटट करने को कहें िसैा करें जसैा की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

364. To stop video time at 9 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 34 सकंेि । 

Stop video here and ask students to do ‘summary slide and expand slide’ as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘समरी स्लाइि और एक्सपिं स्लाइि’ विकल्प को करन े

के वलए कहें जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have practiced ‘summary slide and expand slide’ 

option or not and play the video again. 

अब चके करें विद्यार्थटयों ने ‘समरी स्लाइि और एक्सपिं स्लाइि’ विकल्प का अभ्यास ककया 

है या नहीं और किर आगे के विवियो को प्ले करें। 

365. To stop video time at 9 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 47 सकंेि । 

 

Stop video here and ask students to insert slides and do the practice of  

‘animated Image’ option as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  स्लाइि इन्सटट करन ेको कहें और ‘अवनमटेेि इमजे’ 

विकल्प का अभ्यास करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘animated image’ option or not and 

play the video again for correct answer. 
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अब चके करें विद्यार्थटयों ने ‘अवनमटेेि इमजे’ विकल्प का अभ्यास ककया है या नहीं और 

किर सही उत्तर के वलए आगे के विवियो को प्ले करें। 

366. To stop video time at 10 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 35 सकंेि । 

Stop video here and ask students to click on ‘custom animation’ option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘कस्टम एवनमशेन’ विकल्प पर वक्लक करन ेके वलए कहें 

जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

367. To stop video time at 11 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 16 सकंेि । 

Stop video here and ask students to insert a picture and click on apply option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र को इन्सटट करें और अप्लाई के विकल्प पर वक्लक 

करन ेके वलए कहें जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

368. To stop video time at 13 minute 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 38 सकंेि । 

Stop video here and ask students to insert a picture and click on apply option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र को इन्सटट करें और अप्लाई के विकल्प पर वक्लक 

करन ेके वलए कहें जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

369. To stop video time at 14 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 20 सकंेि । 

Stop video here and ask students to insert a picture and click on apply option as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र को इन्सटट करें और अप्लाई के विकल्प पर वक्लक 

करन ेके वलए कहें जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have practiced ‘animated image’ option or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने ‘अवनमटेेि इमजे’ विकल्प का अभ्यास ककया है या नहीं और 

किर आगे के विवियो को प्ले करें। 

370. To stop video time at 14 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 31 सकंेि । 
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Stop video here and ask students to insert slides and do the practice of  ‘Position 

and size’ option as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  स्लाइि इन्सटट करन ेको कहें और ‘पोवजशन और साइज़’ 

विकल्प का अभ्यास करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘Position and size’ option or not 

and play the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘पोवजशन और साइज़’ विकल्प का अभ्यास ककया ह ैया नहीं 

और किर सही उत्तर के वलए आगे के विवियो को प्ले करें। 

371. To stop video time at 15 minute 18 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 18 सकंेि । 

Stop video here and ask students to insert a slide and draw a picture as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक न्यू स्लाइि को इन्सटट करन ेके वलए कहें और किर 

एक वचत्र ड्रॉ करें जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

372. To stop video time at 16 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 36 सकंेि । 

Stop video here and ask students to go to insert menu and choose ‘position and 

size’ option and do as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों से कहें की इन्सटट मनेू पर जायें और किर ‘पोजीसन और 

साइज़’ विकल्प को चनुे जसैा की विवियो मे कदखाया गया िसैा करें और किर आगे विवियो 

को प्ले करें। 

Now just check whether they have done ‘Position and size’ option or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने ‘पोवजशन और साइज़’ विकल्प का ककया है या नहीं और किर 

आगे के विवियो को प्ले करें। 
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373. To stop video time at 17 minute 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 01 सकंेि । 

 

Stop video here and ask students to insert slides and do the practice of  ‘Line’ 

option as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  स्लाइि इन्सटट करन ेको कहें और ‘लाइन’ विकल्प का 

अभ्यास करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘line’ option or not and play the 

video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘लाइन’ विकल्प का अभ्यास ककया है या नहीं और किर सही 

उत्तर के वलए आगे के विवियो को प्ले करें। 

374. To stop video time at 19 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 50 सकंेि । 

Stop video here and ask students to as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को कहें जसैा की विवियो मे कदखाया गया िसैा करें और 

किर आगे विवियो को प्ल ेकरें। 

Now just check whether they have done ‘line’ option or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने ‘लाइन’ विकल्प का अभ्यास ककया है या नहीं और आगे के 

विवियो को प्ले करें। 

375. To stop video time at 20 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 08 सकंेि । 



   

 Supported By “Human Development Foundation” 121 
 
  
 

 

Stop video here and ask students to do the practice of  ‘area’ option as shown in 

the video. 

विवियो को रोके और विद्यार्थटयों को ‘एररया’ विकल्प का अभ्यास करन ेको कहें को जसैा की 

विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘area’ option or not and play the 

video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘एररया’ विकल्प का अभ्यास ककया है या नहीं और किर सही 

उत्तर के वलए आगे के विवियो को प्ले करें। 

376. To stop video time at 21 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 08 सकंेि । 

Stop video here and ask students to insert a new slide and draw a picture as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें एक न्यू स्लाइि को इन्सटट करें और किर एक वचत्र 

को ड्रॉ करें जसैा की विवियो मे कदखाया गया किर आगे विवियो को प्ले करें। 

377. To stop video time at 23 minute 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 45 सकंेि । 

Stop video here and ask students to change their formatting using ‘area’ option 

as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें ‘एररया’ विकल्प के उपयोग स ेअपने वचत्र की 

िोमटेटंग को बदलें जसैा की विवियो मे कदखाया गया किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘area’ option or not and play the video 

again. 

अब चके करें विद्यार्थटयों ने ‘एररया’ विकल्प का उपयोग ककया ह ैया नहीं और किर आगे के 

विवियो को प्ले करें। 

378. To stop video time at 23 minute 51 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 51 सकंेि । 

 

Stop video here and ask students to type this line as shown in the video. 

विवियो को रोके और विद्यार्थटयों को इस लाइन को टाइप करन ेको कहें जसैा की विवियो मे 

कदखाया गया । 

Now just check whether they have typed or not and play the video again. 

अब चके करें विद्यार्थटयों ने टाइप ककया ह ैया नहीं और किर आगे के विवियो को प्ले करें। 

379. To stop video time at 23 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 54 सकंेि । 

 

Stop video here and ask students to do practice of ‘spelling’ option as shown in 

the video. 

विवियो को रोके और विद्यार्थटयों को ‘स्पपे्लगं’ विकल्प का अभ्यास करन ेको कहें जसैा की 

विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘spelling’ option or not and play 

the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘स्पपे्लंग’ विकल्प का अभ्यास ककया ह ैया नहीं और किर सही 

उत्तर के वलए आगे के विवियो को प्ले करें। 

380. To stop video time at 26 minute 34 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 34 सकंेि । 

Stop video here and ask students to correct their spelling using ‘spelling & 

grammar’ option as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें ‘स्पपे्लंग & ग्रैमर’ विकल्प के उपयोग से अपन े

स्पपे्लगं को ठीक करें जसैा की विवियो मे कदखाया गया किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘spelling & grammar’ option or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने ‘स्पपे्लंग & ग्रमैर’ विकल्प का उपयोग ककया ह ैया नहीं और 

किर आगे के विवियो को प्ले करें। 

381. To stop video time at 26 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 40 सकंेि । 

 

Stop video here and ask students to do practice of ‘color replacer’ option as 

shown in the video. 

विवियो को रोके और विद्यार्थटयों को ‘कलर ररप्लसेर’ विकल्प का अभ्यास करन ेको कहें जसैा 

की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘color replacer’ option or not and 

play the video again for correct answer. 

अब चके करें विद्यार्थटयों ‘कलर ररप्लसेर’ विकल्प का अभ्यास ककया है या नहीं और किर 

सही उत्तर के वलए आगे के विवियो को प्ले करें। 

382. To stop video time at 28 minute 09 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 09 सकंेि । 

Stop video here and ask students to insert a new slide and picture as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें की एक न्यू स्लाइि और वचत्र को इन्सटट करें जसैा 

की विवियो मे कदखाया गया किर आगे विवियो को प्ले करें। 
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383. To stop video time at 30 minute 02 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 02 सकंेि । 

Stop video here and ask students to change the ‘color of image’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें की वचत्र के ‘कलर को बदलें’ जसैा की विवियो मे 

कदखाया गया किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘color replacer’ option or not and play 

the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘कलर ररप्लसेर’ विकल्प का उपयोग ककया है या नहीं और किर 

आगे के विवियो को प्ले करें। 

384. To stop video time at 30 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 10 सकंेि । 

 

Stop video here and ask students to add ‘spreadsheet’ file as shown in the video. 

विवियो को रोके और विद्यार्थटयों को कहें की ‘स्रिैशीट’ की फ़ाइल को ऐि करें जसैा की 

विवियो मे कदखाया गया । 

Now just check whether they have done or not and play the video again for 

correct answer. 

अब चके करें विद्यार्थटयों ने ककया है या नहीं और किर सही उत्तर के वलए आगे के विवियो 

को प्ले करें। 

385. To stop video time at 32 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 32 वमनट 22 सकंेि । 

Stop video here and ask students to add ‘spreadsheet’ file on current impress 

slide  as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें की इम्प्रसे के स्लाइि पर ‘स्रैिशीट’ की फ़ाइल को 

जोड़े जसैा की विवियो म ेकदखाया गया किर आग ेविवियो को प्ले करें। 

386. To stop video time at 33 minute 10 seconds in VLC Media Player. 



   

 Supported By “Human Development Foundation” 125 
 
  
 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 10 सकंेि । 

Stop video here and ask students to use sum formula as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें की सम के िॉमूटला का उपयोग करें जसैा की 

विवियो मे कदखाया गया किर आगे विवियो को प्ल ेकरें। 

Now just check whether they have done or not and play the video again for 

correct answer. 

अब चके करें विद्यार्थटयों ने ककया है या नहीं और किर सही उत्तर के वलए आगे के विवियो 

को प्ले करें। 

387. To stop video time at 33 minute 13 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 33 वमनट 13 सकंेि । 

 

Stop video here and ask students to do practice of ‘minimize presentation’ as 

shown in the video. 

विवियो को रोके और विद्यार्थटयों को कहें की ‘वमनीमाइज़ रजेेंटसन’ का अभ्यास करें जसैा की 

विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘minimize presentation’ or not and 

play the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘वमनीमाइज़ रजेेंटसन’ अभ्यास ककया ह ैया नहीं और किर सही 

उत्तर के वलए आगे के विवियो को प्ले करें। 

388. To stop video time at 34 minute 18 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 34 वमनट 18 सकंेि । 

Stop video here and ask them to click insert menu and choose ‘minimize 

presentation’ and do as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कहें की इन्सटट मनेू से ‘वमनीमाइज़ रजेेंटसन’ को चनुे 

और जसैा की विवियो म ेकदखाया गया िसैा करें किर आगे विवियो को प्ल ेकरें। 

389. To stop video time at 36 minute 40 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 40 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को कहें जसैा की विवियो मे कदखाया गया िसैा करें किर 

आगे विवियो को प्ले करें। 

Now just check whether they have used ‘minimize presentation’ or not and play 

the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘वमनीमाइज़ रजेेंटसन’ उपयोग ककया है या नहीं और किर सही 

उत्तर के वलए आगे के विवियो को प्ले करें। 

390. To stop video time at 36 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 50 सकंेि । 

 

Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 
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Complete teacher’s manual for Open office Impress 2 Class 9 

Summaries 

 

 Why we use ‘Extension manager’ 

 Why we use ‘Auto correct’ option? 

 Why we use ‘Customize’ option’? 

 How to select any ‘Menu’? 

 How to design the slide? 

 Why we use ‘Option’?  

 Why we use ‘Interaction’? 

 How to apply affects on slide? 

 Why we use Custom animation? 

 Why we use slide transition? 

 Why we use ‘Custom slide show’? 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

391. To stop video time at 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 सकंेि ।  
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Stop video here and ask, what can we change using ‘Area option’? 

विवियो को रोके और पछूें  एररया विकल्प के उपयोग से क्या क्या बदल सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

392. To stop video time at 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 35 सकंेि ।  

 

Stop video here and ask what can we change using ‘Line option’? 

विवियो को रोके और पछूें  लाईन विकल्प के उपयोग स ेक्या क्या बदल सकत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

393. To stop video time at 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 52 सकंेि ।  
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Stop video here and ask , In which Menu ‘Animated image’ can be found and 

why we use it? 

विवियो को रोके और पछूें अवनमटेेि इमजे ककस मनेू आता है और इसका उपयोग क्यो करत े

हैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

1. To stop video time at 1 minute 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 17 सकंेि । 

 

Stop video here and ask why use ‘Text’ option? 

विवियो को रोके और पछूें टेक्स्ट विकल्प का उपयोग करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

2. To stop video time at 1 minute 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 17 सकंेि । 
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Stop video here and ask why we use ‘Crop picture’ option? 

विवियो को रोके और पछूें क्रॉप वपक्चर विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

3. To stop video time at 1 minute 56 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 56 सकंेि । 

 

Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

4. To stop video time at 2 minute 29 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 29 सकंेि । 
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Stop video here and check whether they have opened ‘Impress file’? 

विवियो को रोके और चके करें की विद्यार्थटयों न ेइंरसे फ़ाइल ओपन ककया है या नहीं। 

Now just check and then play the video again. 

अब चके करें किर आगे विवियो को प्ले करें। 

5. To stop video time at 2 minute 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 41 सकंेि । 

 

Stop video here and ask students to insert four slides and type the given 

paragraph on the 1
st
 slide and then play the video again. 

विवियो को रोके और विद्यार्थटयो को चार स्लाइि इन्सटट करन ेको कहें और किर पहली 

स्लाइि मे कदये गए परैाग्राि को टाइप करें और किर आगे विवियो को प्ल ेकरें। 

6. To stop video time at 2 minute 54 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 54 सकंेि । 

Stop video here and ask students to draw any shape on the second slide and also 

ask to type a line about that Shapes and then play the video again. 

विवियो को रोके और विद्यार्थटयो को दसूरे स्लाइि पर कोई शपे ड्रॉ करन ेको कहें और उसके 

बारे म ेएक लाईन वलखें और किर आगे विवियो को प्ल।े 

7. To stop video time at 4 minute 48 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 48 सकंेि । 
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Stop video here and ask students to insert a picture as shown in the video and 

then play video again. 

विवियो को रोके और विद्यार्थटयो को एक वचत्र इन्सटट करन ेको कहें जसैे की विवियो मे 

कदखाया और किर आगे विवियो को प्ले करें। 

8. To stop video time at 5 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 36 सकंेि । 

Stop video here and ask students to design the slide as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयो को स्लाइि विज़ाइन करन ेको कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

9. To stop video time at 6 minute 33 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 33 सकंेि । 

Stop video here and ask students to design the slide as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयो को स्लाइि विज़ाइन करन ेको कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

10. To stop video time at 6 minute 33 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 33 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

11. To stop video time at 6 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 47 सकंेि । 

 

Stop video here and tell students that now they will learn about ‘Extension 

manager’ and how to use it? 
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विवियो को रोके और विद्यार्थटयो को बताए की अब एक्सटेन्सन मनैजेर के बारे मे सीखेंगे और 

इसका उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

12. To stop video time at 8 minute 32 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 32 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Extension manager’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर 

एक्सटेन्सन मनैजेर पर वक्लक करन ेको कहें जसै ेकी विवियो मे कदखाया गया है और किर 

आगे विवियो प्ले करें। 

13. To stop video time at 9 minute 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 46 सकंेि । 

Stop video here and ask students to download any extension as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कोई एक्सटेन्सन िाउनलोि करन ेको कहें जसैा की 

विवियो मे कदखाया ह ैऔर किर आगे विवियो को प्ले करन ेको कहें। 

Note: - internet connection is required to download any contents. 

नोट: -  ककसी भी कंटैंट को िाउनलोि करन ेके वलए इंटरनटे कनकै्शन की जरूरत होती हैं।  

14. To stop video time at 11 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 52 सकंेि । 

Stop video here and ask students to open the Extension which they had 

downloaded as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को िाउनलोि ककया हुआ एक्सटैन्शन को ओपन करन ेको 

कहें जसैा की विवियो म ेकदखाया गया और किर आगे विवियो को प्ले करें। 

15. To stop video time at 13 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 26 सकंेि । 

Stop video here and ask students to check the extension which they had 

installed and play the video again. 

विवियो को रोके और विद्यार्थटयों को एक्सटैन्शन को चके करन ेको कहें वजसे इन्स्टाल ककया 

था और किर आगे विवियो को प्ले करें। 

16. To stop video time at 14 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 34 सकंेि । 

Stop video here and ask students to do as shown in the video. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

17. To stop video time at 14 minute 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 41 सकंेि । 

 

Stop video here and ask why we use ‘Auto correct’? 

विवियो को रोके और पूछें ऑटो करेक्ट विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

18. To stop video time at 15 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 30 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Auto correct’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर ऑटो 

करेक्ट पर वक्लक करन ेको कहें जसैे की विवियो म ेकदखाया गया है और किर आगे विवियो 

प्ले करें। 

19. To stop video time at 17 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 26 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

20. To stop video time at 18 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 59 सकंेि । 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

21. To stop video time at 19 minute 28 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 28 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

22. To stop video time at 19 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 34 सकंेि । 

 

Stop video here and ask do they know why we use ‘Customize’ option? 

विवियो को रोके और पूछें क्या आप जानत ेहै कस्टमाईज़ विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

23. To stop video time at 21 minute 42 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 42 सकंेि । 

Stop video here and ask students to remove ‘Hyperlink’ and ‘Object’ option 

from ‘Edit menu’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एविट मनेू स ेहाइपरप्लकं और ऑब्जके्ट विकल्प को हटान े

कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

24. To stop video time at 23 minute 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 01 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

25. To stop video time at 24 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 52 सकंेि । 

Stop video here and ask students to create a ‘Menu’ as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक मनेू कक्रएट करन ेको कहें जसै ेकी विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

26. To stop video time at 25 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 36 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

27. To stop video time at 25 minute 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 46 सकंेि । 

 

Stop video here and ask why we use ‘Option’ option? 

विवियो को रोके और पछूें िील््स ऑप्शन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

28. To stop video time at 26 minute 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 24 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Option’ as shown in the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर ऑप्शन 

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

29. To stop video time at 28 minute 04 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 04 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

30. To stop video time at 28 minute 27 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 वमनट 27 सकंेि । 

Stop video here and ask students to do the normal view as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को नॉमटल व्यू म ेकरन ेको कह ेजसैे की विवियो मे कदखाया 

गया ह ैऔर किर आगे विवियो को प्ले करें। 

31. To stop video time at 30 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 30 वमनट 15 सकंेि । 

Stop video here and ask students to create own color name as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को अपने नाम का कलर बनाने को कहे जसैे की विवियो मे 

कदखाया गया हैं और किर आगे विवियो को प्ले करें। 

32. To stop video time at 36 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 14 सकंेि । 

Stop video here and ask students to create own color name as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को अपने नाम का कलर बनान ेको कहे जसैे की विवियो मे 

कदखाया गया हैं और किर आगे विवियो को प्ले करे। 

33. To stop video time at 36 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 36 वमनट 14 सकंेि । 

Stop video here and ask students to edit the ‘Grid’ option as shown  in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वग्रि विकल्प को एविट करन ेको कहें जसैे की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

34. To stop video time at 39 minute 47 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 39 वमनट 47 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

35. To stop video time at 40 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 40 वमनट 21 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

36. To stop video time at 40 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 40 वमनट 31 सकंेि । 

 

Stop video here and ask why we use ‘Interaction’ option? 

पूछें इंटरेक्शन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

37. To stop video time at 41 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 41 वमनट 21 सकंेि । 

Stop video here and ask students to type any word on the title box as shown in 

the video and then play the video again. 

 विवियो को रोके और विद्यार्थटयों टाइटल बॉक्स म ेकोई ििट टाइप करन ेको कह ेजसैे की 

विवियो मे कदखाया गया हैं। 

38. To stop video time at 41 minute 31 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 41 वमनट 31 सकंेि । 
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Stop video here and ask students to click on the ‘Tools  menu’ and then click on 

‘Interaction’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक करन ेको कहें और किर इंटरेक्शन 

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

39. To stop video time at 42 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 42 वमनट 10 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

40. To stop video time at 44 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 00 सकंेि । 

Stop video here and ask students to attach any document in title slide as shown 

in the video. 

विवियो को रोके और विद्यार्थटयों को स्लाइि मे कोई िॉकयमुेंट इन्सटट करन ेको कहें जसैे की 

विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

41. To stop video time at 44 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 05 सकंेि । 

 

Stop video here and ask why we use ‘Slide transition’ option? 

विवियो को रोके और पछूें स्लाइि ट्रानवजशन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

42. To stop video time at 44 minute 42 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 44 वमनट 42 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Slide transition’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर स्लाइि 

ट्राजंीशन पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

43. To stop video time at 45 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 45 वमनट 36 सकंेि । 

Stop video here and ask students to apply the effects on slides as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइिस पर इिैक्ट लगाने को कहें जसैे की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

44. To stop video time at 46 minute 36 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 46 वमनट 36 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check whether they have applied ‘Slide transition’ or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने स्लाइि ट्राजंीशन लगाया है या नहीं और किर आगे विवियो को 

प्ले करें। 

45. To stop video time at 46 minute 41 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 46 वमनट 41 सकंेि । 

 

Stop video here and ask why we use ‘Custom animation’ option? 

विवियो को रोके और पछूें कस्टम एवनमेशन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 
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46. To stop video time at 47 minute 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 47 वमनट 55 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

47. To stop video time at 48 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 48 वमनट 21 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

48. To stop video time at 48 minute 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 48 वमनट 39 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Custom animation’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर कस्टम 

एवनमेशन पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे 

विवियो प्ले करें। 

49. To stop video time at 50 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 50 वमनट 06 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

50. To stop video time at 50 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 50 वमनट 52 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

51. To stop video time at 51 minute 01 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 51 वमनट 01 सकंेि । 
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Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 
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Complete teacher’s manual for Open office impress 2 Class 10 

Class 10 Summaries 

 

 How to record a data, picture and drawing in impress file? 

 Why we use extension manager ? 

 How to use auto correct option ? 

 What is rehearse timing ? 

 Why we use interaction ? 

 How to use slide transition ? 

 Why we use custom slide show ? 

 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

52. To stop video time at 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 सकंेि ।  
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Stop video here and ask Why we use spelling ? 

विवियो को रोके और पछूें  स्पपे्लगं का उपयोग क्यों करत ेहै ? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

53. To stop video time at 28 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 28 सकंेि ।  

 

Stop video here and ask Why we custom animation ? 

विवियो को रोके और पछूें  कस्टम एवनमेशन का उपयोग क्योंक करत ेहैं ? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

54. To stop video time at 49 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 49 सकंेि ।  

 

Stop video here and ask what is customize ? 

विवियो को रोके और पछूें  कस्टमाइज़ क्या होता है ? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 
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55. To stop video time at 1 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 10 सकंेि ।  

 

Stop video here and ask Why we use interaction ? 

विवियो को रोके और पछूें  इंटरएक्शन का उपयोग क्यों करत ेहैं ? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

56. To stop video time at 1 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 40 सकंेि ।  

 

Stop video here and ask if they know what is custom slide show ? 

विवियो को रोके और पछूें  क्या आप जानत ेहैं कस्टम स्लाइि शो क्या होता हैं ? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

57. To stop video time at 2 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 03 सकंेि ।  
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Stop video here and ask students to turn on their computer and open  ‘Impress 

file’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कम्प्प्यटुर को ऑन करें और इम्प्रसे की फ़ाइल को ओपने 

करन ेको कहें और किर आगे विवियो को प्ले करें। 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

58. To stop video time at 2 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 26 सकंेि ।  

 

Stop video here and ask students to insert 5 new slides and type this paragraph 

about ‘Computer Shiksha’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को 5 न्यू स्लाइि को इन्सटट करें और इस परैाग्राि या 

कम्प्प्यटुर वशक्षा के बारे म ेटाइप करन ेको कहें और किर आगे विवियो को प्ले करें। 

59. To stop video time at 2 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 47सकंेि ।  



   

 Supported By “Human Development Foundation” 147 
 
  
 

  

Stop video here and ask students to insert picture and do formatting on this 

picture,  after that they should practice ‘Custom animation’ option and then play 

the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र को इन्सटट करें और उसकी िोमटेटंग भी करें उसके 

बाद आप कस्टम एवनमशेन का उपयोग करें करन ेको कहें और किर आगे विवियो को प्ले करें। 

60. To stop video time at 4 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 4 वमनट 40 सकंेि । 

Stop video here and ask students to insert slides and draw shape using drawing 

toolbar as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों स्लाइि इन्सटट और ड्राप्िंग टूलबार की मदद स ेशपे को ड्रॉ 

करन ेको कहें को जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

61. To stop video time at 5 minute 42 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 42 सकंेि । 

Stop video here and ask students to draw shape using drawing toolbar and give 

the title for this picture as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ड्राप्िगं टूलबार की मदद से शपे को ड्रॉ और इस वचत्र 

के टाइटल को दने ेके वलए कहें को जसैा की विवियो मे कदखाया गया और किर आगे विवियो 

को प्ले करें। 

62. To stop video time at 6 minute 18 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 18 सकंेि । 

Stop video here and ask students to insert a picture from file option shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल विकल्प स ेवचत्र को इन्सटट करन ेको कहें जसैा की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

63. To stop video time at 8 minute 46 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 46 सकंेि । 
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Stop video here and ask students to change the ‘slide design’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘स्लाइि के विज़ाइन’ को बदलने को कहें को जसैा की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

64. To stop video time at 11 minute 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 45 सकंेि । 

Stop video here and ask students to use ‘custom animation’ and then show the 

slide show as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कस्टम एवनमशेन का उपयोग और किर स्लाइि शो करन े

को कहें को जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘Custom animation’ or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने ‘कस्टम एवनमेशन’ का उपयोग ककया है या नहीं और किर आगे 

विवियो को प्ले करें। 

65. To stop video time at 11 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 59 सकंेि । 

 

Stop video here and ask students to open another file using ‘Interaction’ option 

as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  ‘इंटरएक्शन’ विकल्प के उपयोग स ेककसी और फ़ाइल 

को ओपने करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘Interaction’ option or not and play 

the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘इंटरएक्शन’ विकल्प का अभ्यास ककया है या नहीं और किर 

सही उत्तर के वलए आगे के विवियो को प्ले करें। 

66. To stop video time at 14 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 08 सकंेि । 
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Stop video here and ask students to use ‘Interaction’ option as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘इंटरएक्शन’ विकल्प का उपयोग करने के वलए कहें जसैा 

की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘Interaction’ option or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने ‘इंटरएक्शन’ विकल्प का उपयोग ककया ह ैया नहीं और किर आगे 

के विवियो को प्ले करें। 

67. To stop video time at 9 minute 47 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 47 सकंेि । 

 

Stop video here and ask students to do the practice of ‘Custom animation’ on 

every slide as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  हर एक स्लाइि पर ‘कस्टम एवनमशेन’ का अभ्यास 

करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘custom animation’ option or not 

and play the video again for correct answer. 

अब चके करें विद्यार्थटयों ने ‘कस्टम एवनमेशन’ विकल्प का अभ्यास ककया है या नहीं और 

किर सही उत्तर के वलए आगे के विवियो को प्ले करें। 

68. To stop video time at 16 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 20 सकंेि । 

Stop video here and ask students to change the ‘effects’ of every slide one by 

one using custom animation as shown in the video and then play the video 

again. 
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विवियो को रोके और विद्यार्थटयों को कस्टम एवनमशेन के उपयोग से एक-एक करके हर एक 

स्लाइि के एिफ़ेक्लस को बदलन ेको कहें को जसैा की विवियो मे कदखाया गया और किर 

आगे विवियो को प्ले करें। 

69. To stop video time at 17 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 59 सकंेि । 

Stop video here and ask students to change the ‘effects’ of every slide one by 

one using custom animation  and show your slide show as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कस्टम एवनमशेन के उपयोग से एक-एक करके हर एक 

स्लाइि के एिफ़ेक्लस को बदलन ेको कहें और किर स्लाइि शो करन ेको कहें जसैा की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘Custom animation’ option or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने ‘कस्टम एवनमशेन’ विकल्प का उपयोग ककया ह ैया नहीं और 

किर आगे के विवियो को प्ले करें। 

70. To stop video time at 18 minute 07 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 18 वमनट 77 सकंेि । 

 

Stop video here and ask students to do the practice of ‘rehearse timing’ on every 

slide as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  हर एक स्लाइि पर ‘रेहयेस ेटाइप्मगं’ का अभ्यास करन े

को कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘rehearse timing’ option or not and 

play the video again for correct answer. 

अब चके करें विद्यार्थटयों ‘रेहयेस ेटाइप्मगं’ विकल्प का अभ्यास ककया है या नहीं और किर 

सही उत्तर के वलए आगे के विवियो को प्ले करें। 

71. To stop video time at 20 minute 35 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 35 सकंेि । 

Stop video here and ask students to give the time for automatic slide show with 

time of every slide one by one using ‘rehearse timing’ as shown in the video 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘रेहयेस ेटाइप्मंग’ के उपयोग स ेएक-एक करके हर एक 

स्लाइि पर टाइम दनेे को कहें को जसैा की विवियो मे कदखाया गया और किर आगे विवियो 

को प्ले करें। 

72. To stop video time at 22 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 30 सकंेि । 

Stop video here and ask students to give the time for automatic slide show with 

time of every slide one by one using ‘rehearse timing’ and then play the slide 

show as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘रेहयेस ेटाइप्मंग’ के उपयोग स ेएक-एक करके हर एक 

स्लाइि पर टाइम दनेे को कहें को और किर स्लाइि शो करन ेको कहें जसैा की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘Rehearse timing’ option or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने ‘रेहयेस ेटाइप्मगं’ विकल्प का उपयोग ककया ह ैया नहीं और किर 

आगे के विवियो को प्ले करें। 

73. To stop video time at 22 minute 44 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 44 सकंेि । 

 

Stop video here and ask students to do the practice of ‘Styles and formatting’ on 

every slide as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  हर एक स्लाइि पर ‘स्टाइल & िोमटेटंग’ का अभ्यास 

करन ेको कहें को जसैा की विवियो मे कदखाया गया । 
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Now just check whether they have practiced ‘Styles and formatting’ option or 

not and play the video again for correct answer. 

अब चके करें विद्यार्थटयों ‘स्टाइल & िोमटेटंग’ विकल्प का अभ्यास ककया है या नहीं और 

किर सही उत्तर के वलए आगे के विवियो को प्ले करें। 

74. To stop video time at 23 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 59 सकंेि । 

Stop video here and ask students to change the background of slide as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को की िह अपन ेस्लाइि के बकै्ग्राउण्ि के कलर को बदलें 

जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

Now just check whether they have used ‘Styles & formatting’ option or not and 

play the video again. 

अब चके करें विद्यार्थटयों ने ‘स्टाइल & िोमटेटंग’ विकल्प का उपयोग ककया है या नहीं और 

किर आगे के विवियो को प्ले करें। 

75. To stop video time at 24 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 14 सकंेि । 

 

Stop video here and ask students to do the practice of ‘Slide Transition’ on 

every slide as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  हर एक स्लाइि पर ‘स्लाइि टै्रनवजशन’ का अभ्यास 

करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘Slide Transition’ option or not and 

play the video again for correct answer. 

अब चके करें विद्यार्थटयों ‘स्लाइि टै्रनवजशन’ विकल्प का अभ्यास ककया है या नहीं और किर 

सही उत्तर के वलए आगे के विवियो को प्ले करें। 

76. To stop video time at 26 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 59 सकंेि । 
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Stop video here and ask students to give the effects using ‘slide transition’ and 

show slide show as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को की िह अपन ेस्लाइि पर ‘स्लाइि टै्रनवजशन’ विकल्प के 

उपयोग से एिफ़ेक्लस को दें और स्लाइि शो करें जसैा की विवियो मे कदखाया गया और किर 

आगे विवियो को प्ले करें। 

Now just check whether they have used ‘slide transition’ option or not and play 

the video again. 

अब चके करें विद्यार्थटयों न े‘स्लाइि टै्रनवजशन’ विकल्प का उपयोग ककया है या नहीं और 

किर आगे के विवियो को प्ले करें। 

77. To stop video time at 27 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 05 सकंेि । 

 

Stop video here and ask students to do the practice of ‘slide show’ of every slide 

as shown in the video. 

विवियो को रोके और विद्यार्थटयों को  हर एक स्लाइि को ‘स्लाइि शो’ करन ेका अभ्यास 

करन ेको कहें को जसैा की विवियो मे कदखाया गया । 

Now just check whether they have practiced ‘slide show’ option or not and play 

the video again for correct answer. 

अब चके करें विद्यार्थटयों विकल्प ‘स्लाइि शो’ का अभ्यास ककया ह ैया नहीं और किर सही 

उत्तर के वलए आगे के विवियो को प्ले करें। 

78. To stop video time at 29 minute 55 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 55 सकंेि । 

Stop video here and ask students to change the ‘effects’ of every slide one by 

one using ‘custom animation’ as shown in the video and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को ‘कस्टम एवनमेशन’ के उपयोग से एक-एक करके हर 

एक स्लाइि के एिफ़ेक्लस को बदलने को कहें को जसैा की विवियो मे कदखाया गया और किर 

आगे विवियो को प्ले करें। 

79. To stop video time at 32 minute 59 seconds in VLC Media Player. 
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VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 32 वमनट 59 सकंेि । 

Stop video here and ask students to set the ‘effects and timing’ of every slide 

one by one using ‘custom animation’ as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को ‘कस्टम एवनमेशन’ के उपयोग से एक-एक करके हर 

एक स्लाइि के एिफ़ेक्लस और टाइप्मगं को सटे करन ेको कहें जसैा की विवियो मे कदखाया 

गया और किर आगे विवियो को प्ले करें। 

80. To stop video time at 34 minute 59 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 34 वमनट 59 सकंेि । 

Stop video here and ask students to ‘remove’ the effects and after that set the 

‘effects and timing’ of every slide one by one using ‘custom animation’ as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘कस्टम एवनमेशन’ के उपयोग से एिफ़ेक्लस को ररमिू 

करें और उसके बाद किर एक-एक करके हर एक स्लाइि के एिफ़ेक्लस और टाइप्मगं को सटे 

करन ेको कहें जसैा की विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

81. To stop video time at 37 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 37 वमनट 05 सकंेि । 

Stop video here and ask students to use ‘slide transition’ on every slide and 

show the ‘slide show’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को ‘स्लाइि टै्रनवजशन’ का उपयोग हर एक स्लाइि पर 

करन ेको और किर ‘स्लाइि शो’ करन ेको कहें जसैा की विवियो मे कदखाया गया और किर 

आगे विवियो को प्ले करें। 

82. To stop video time at 37 minute 15 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 37 वमनट 15 सकंेि । 

 

Stop video here and ask students to close their file and shut down the computer. 
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विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Complete teacher’s manual for Open office Impress 2 Class 11 

Class 11 Summaries 

 

 Why we use ‘Interaction’ 

 Why we use ‘Custom animation’ option? 

 Why we use ‘Color replacer’ option’? 

 How to do any ‘Formatting on drawing? 

 How to insert a new slide? 

 How to use slides into ‘Summary slide’?  

 Why we use ‘Expand slide’? 
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 What happens by ‘Properties’ option? 

 What happens by ‘Hyperlink’ option? 

 Why we use ‘Slide transition’? 

 

Now let’s start the video. 

अब विवियो को शरुू करें ।  

 

83. To stop video time at 17 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 सकंेि ।  

 

Stop video here and ask why we use ‘Interaction’ option’? 

विवियो को रोके और पछूें  इंटरररएक्शन विकल्प का उपयोग क्यों करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

84. To stop video time at 43 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 43 सकंेि ।  

 

Stop video here and ask why we use ‘Slide transition’ option? 

विवियो को रोके और पछूें स्लाइि ट्राजंीशन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 
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जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

85. To stop video time at 1 minute 05 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 05 सकंेि । 

 

Stop video here and ask why we use ‘Minimize presentation’ option? 

विवियो को रोके और पछूें वमवनमाइज़ रजेेंटेशन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

86. To stop video time at 1 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 22 सकंेि । 

 

Stop video here and ask why we use ‘Slide design’ option? 

विवियो को रोके और पछूें स्लाइि विज़ाइन विकल्प का उपयोग क्यो करत ेहैं? 

Just listen to the answers and play the video again for the correct answer. 

जिाब सनुे और सही जिाब के वलए आगे के विवियो को प्ले करें । 

87. To stop video time at 1 minute 35 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 1 वमनट 35 सकंेि । 
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Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

विवियो को रोके और विद्यार्थटयों को इम्प्रसे की फ़ाइल को ओपने करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

88. To stop video time at 2 minute 08 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 08 सकंेि । 

Stop video here and ask students to insert four slides and also to change design 

of each slide and then play the video again. 

विवियो को रोके और विद्यार्थटयों को चार स्लाइि इन्सटट करन ेको कहें और हर एक स्लाइि 

का विज़ाइन भी बदलने को कहें और किर आगे विवियो को प्ले करें। 

89. To stop video time at 2 minute 23 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 2 वमनट 23 सकंेि । 

Stop video here and ask students to type about ‘Computer Shiksha’ or ‘their 

own School’ and also to do formatting on the paragraph as explained in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कम्प्प्यटुर वशक्षा के या स्कूल के बारे मे टाइप करन ेको 

कहें और उसन ेिोमटेटंग भी करन ेको कहें जसैे की विवियो मे बताया गया है और किर आगे 

विवियो को प्ले करें। 

90. To stop video time at 3 minute 23 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 3 वमनट 23 सकंेि । 

Stop video here and ask students to change the design of the slide as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि का विज़ाइन बदलन ेको कहें जसै की विवियो मे 

कदखाया गया और किर आगे विवियो को प्ले करें। 

91. To stop video time at 5 minute 18 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 5 वमनट 18 सकंेि । 
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Stop video here and ask students to change the design of the all slides as shown 

in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को सभी स्लाइि का विज़ाइन बदलने को कहें जसै की 

विवियो मे कदखाया गया और किर आगे विवियो को प्ले करें। 

92. To stop video time at 6 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 6 वमनट 06 सकंेि । 

Stop video here and ask students to do formatting as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को जसैे विवियो मे कदखाया गया िसै ेिोमटेटंग करन ेको 

कहें और आगे विवियो को प्ले करें। 

93. To stop video time at 7 minute 10 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 10 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

94. To stop video time at 7 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 14 सकंेि । 

Now just check whether they have done all these formatting or not and play the 

video again. 

अब चके करें विद्यार्थटयों ने य ेसभी िोमटेटंग ककया है या नहीं और किर आगे विवियो को 

प्ले करें। 

95. To stop video time at 7 minute 30 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 7 वमनट 30 सकंेि । 

 

Stop video here and ask students to apply the ‘Custom animation’ as shown in 

the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को कस्टम एवनमशेन लगाने को कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

96. To stop video time at 8 minute 38 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 8 वमनट 38 सकंेि । 

Stop video here and ask students to draw some objects on the slide as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कुछ ऑब्जके्ट स्लाइि पर ड्रॉ करने को कहें जसैे की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

97. To stop video time at 9 minute 32 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 9 वमनट 32 सकंेि । 

Stop video here and ask students to insert any picture on the slide as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि पर कोई वचत्र को इन्सटट करने करन ेको कहें जसै े

की विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

98. To stop video time at 10 minute 14 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 10 वमनट 14 सकंेि । 

Stop video here and ask students to apply ‘Custom animation’ as shown in the 

video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कस्टम एवनमशेन लगाने को कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

99. To stop video time at 11 minute 24 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 11 वमनट 24 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

100. To stop video time at 12 minute 00 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 00 सकंेि । 

Stop video here and ask students to show slide as shown in the video. 

विवियो को रोके और विद्यार्थटयों को स्लाइि शो करन ेको कह ेजसैे की विवियो मे कदखाया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

101. To stop video time at 12 minute 16 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 12 वमनट 16 सकंेि । 
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Stop video here and ask students to insert some pictures and also practice ‘Color 

replacer’ and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कुछ वचत्र को इन्सटट करन ेको कहें और कलर ररप्लसेर 

का अभ्यास करन ेको कहें जसैे की विवियो मे कदखाया गया और किर आगे विवियो को प्ले 

करें। 

102. To stop video time at 13 minute 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 13 वमनट 58 सकंेि । 

Stop video here and ask students to draw some shapes and also do formatting as 

shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को कुछ शेप्स ड्रॉ करन ेको कहें और उसमे िोमटेटंग भी 

करन ेको कहें जसैे की विवियो मे कदखाया गया ह ैऔर किर आगे विवियो को प्ले करें। 

103. To stop video time at 14 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 14 वमनट 50 सकंेि । 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Color replacer’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को टूल्स मने ूपर वक्लक  करन ेको कहें और किर कलर 

ररप्लसे पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो 

प्ले करें। 

104. To stop video time at 15 minute 52 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 52 सकंेि । 

Stop video here and ask students to replace the background color of the picture 

as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को वचत्र के बैक्ग्राउण्ि कलर को बदलन ेको कहें जसैे की 

विवियो मे कदखाया गया था और किर आगे विवियो को प्ले करें। 

105. To stop video time at 15 minute 57 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 15 वमनट 57 सकंेि । 
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Stop video here and ask students to do practice of ‘Slide transition’ and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों को स्लाइि ट्राजंीशन का अभ्यास करन ेको कहें और किर 

आगे विवियो को प्ले करें। 

106. To stop video time at 16 minute 34 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 16 वमनट 34 सकंेि । 

Stop video here and ask students to apply effects and sound effects as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एफ़ेक्लस और साउंि एफ़ेक्लस लगाए को कहन ेजसै ेकी 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

107. To stop video time at 17 minute 56 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 17 वमनट 56 सकंेि । 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया है िसैा करन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

108. To stop video time at 19 minute 06 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 06 सकंेि । 

Stop video here and ask students to do slide show as shown in the video. 

विवियो को रोके और विद्यार्थटयों को स्लाइि  शो करन ेको कहें जसैे की विवियो मे कदखाया 

गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

109. To stop video time at 19 minute 11 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 19 वमनट 11 सकंेि । 
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Stop video here and ask students to do practice of ‘Summary slide’ and then 

play the video again. 

विवियो को रोके और विद्यार्थटयों को समरी स्लाइि का अभ्यास करन ेको कहें और किर आगे 

विवियो को प्ले करें। 

110. To stop video time at 20 minute 26 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 20 वमनट 26 सकंेि । 

Stop video here and ask students to type some title as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को कुछ टाइप करन ेको कहें जसैे की विवियो मे कदखाया 

गया और किर आगे विवियो को प्ले करें। 

111. To stop video time at 21 minute 21 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 21 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

112. To stop video time at 21 minute 27 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 21 वमनट 27 सकंेि । 
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Stop video here and ask students to convert ‘Summary slide into ‘Title slide’ 

and then play the video again. 

विवियो को रोके और विद्यार्थटयों को समरी स्लाइि को टाइटल स्लाइि म ेबदलन ेको कहें और 

किर आगे विवियो को प्ल ेकरें। 

113. To stop video time at 22 minute 22 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 22 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

114. To stop video time at 22 minute 39 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 22 वमनट 39 सकंेि । 

Stop video here and ask students to insert one more slide and in this slide ask 

them to attach any file on it as shown in video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को एक और स्लाइि इन्सटट करन ेको कहें और इस स्लाइि 

मे ककसी फ़ाइल को अटैच करन ेको कहें जसैे की विवियो मे बताया गया ह ैऔर किर आगे 

विवियो को प्ले करें। 

115. To stop video time at 23 minute 03 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 23 वमनट 30 सकंेि । 

Stop video here and ask students to click on the ‘Hyperlink’ option as shown in 

the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को हाइपरप्लकं विकल्प पर वक्लक करन ेको कहें जसैे की 

विवियो मे कदखाया गया है और किर आगे विवियो को प्ले करें। 

116. To stop video time at 24 minute 45 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 24 वमनट 45 सकंेि । 
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Stop video here and ask students to insert hyperlink as shown in the video and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को हाइपरप्लकं को इन्सटट करन ेको कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो प्ले करें। 

117. To stop video time at 25 minute 25 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 25 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

118. To stop video time at 25 minute 40 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 25 वमनट 40 सकंेि । 

 

Stop video here and ask students to convert their file into ‘MS Power point’ and 

then play the video again. 

विवियो को रोके और विद्यार्थटयों को फ़ाइल को एमएस पािर पॉइंट मे बदलने को कहें और 

किर आगे विवियो को प्ल ेकरें। 

119. To stop video time at 26 minute 11 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 26 वमनट 11 सकंेि । 

Stop video here and ask students to click on the ‘Insert menu’ and then click on 

‘Object’ as shown in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों को इन्सटट मनेू पर वक्लक  करन ेको कहें और किर ऑब्जके्ट 

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

Stop video here and ask students to click on the ‘File menu’ and then click on 

‘Wizard’ as shown in the video and then play the video again. 
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विवियो को रोके और विद्यार्थटयों को फ़ाइल मने ूपर वक्लक  करन ेको कहें और किर विजािट 

पर वक्लक करन ेको कहें जसैे की विवियो मे कदखाया गया है और किर आगे विवियो प्ले 

करें। 

120. To stop video time at 27 minute 50 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 50 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

121. To stop video time at 27 minute 58 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 27 वमनट 58 सकंेि । 

 

Stop video here and ask students to tell all information about the file as shown 

in the video and then play the video again. 

विवियो को रोके और विद्यार्थटयों से फ़ाइल के बारे मे बतान ेको को कहें जसैे की विवियो मे 

कदखाया गया है और किर आगे विवियो को प्ले करें। 

122. To stop video time at 29 minute 11 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 11 सकंेि । 

Stop video here and ask students to do as shown in the video. 

विवियो को रोके और विद्यार्थटयों को जसैा विवियो मे कदखाया गया ह।ै 

Now just check and then play the video again. 

अब चके करें और किर आगे विवियो को प्ले करें। 

123. To stop video time at 29 minute 20 seconds in VLC Media Player. 

VLC मीविया प्लयेर मे विवियो को रोकन ेका समय 29 वमनट 20 सकंेि । 
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Stop video here and ask students to close their file and shut down the computer. 

विवियो को रोके और विद्यावथयों को फ़ाइल क्लोज़ करन ेऔर कम्प्प्यटुर को शलिाउन करन ेको 

कहें। 

 

 

 

 


